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Dorico 5 Version History

Dorico 5 Tl&, FL—VY—%RXT—VICEBREL. TORT—C#HARLREDHHZE
MICERET A ET. BETAYIUREEHRL. B HDOHEEELETEHRTLHI L
XIET AFEEEMNEMShELT,

=T ZARSDYHDURSATI) =L, REVFOHR—IL TEEEHNZTERDERME
[ZHEBEL. SESFELGIAMIROLIVTHRETHIET, BRLGRTLAEHENTY
ADENTF=YHIURERRTZELEDIEZ TOVET, Tl A UIAITIEALY)—T
ADOR—INIAIE/ESE SATI)—NFEEN-ERZFRBRLDIIENTEET,

CO7TO—F T LIA—TAV T IV RTOEEERITLTNMS =0,
REBADHDZT YTV IR BRSITEONET, COT7TA—FORRIE. B
LEIMNESTONBERES. ENERRT DD EREFICKEGHERITESETY,

Dorico Pro [CE#REN TLNSA—7 RS ERIHALIon Symphonic Orchestra |z I
CHETBNLODDF =T ALSERIE. AR VEFERL. TRTDAVRARYILA
AERTLABEDHRDISEDFEEND, KYZa—rSLRBHETHRESNTVE
ERD

COFETHNIE, HIOUREEDRATLUAMETERNPI ERELANILDEESL
HLPTLDT, BHENSGYET . LAL REDRT—Y L TEAU ARy ILA
VIrDEEZR T CER. Y VUNICREDRBEEAS-ODBEYLRI I
(FHENST-, —EDEENDEITHEHIEIEETYT,

BRELEAR—ILORECAMRELGY  I19BRLELDHNLZDSATS)—hoD /N
YFEIVIRTHIGEIL. SHICERLEIZBYET,

BREBREELGYOIRIVOZ7THNIE. CNODHEBIZHIGTHAFILAHYET,
Dorico MIFH—I[L, ;K 8 DM Send FroRILEERTEDHEERHMEATF LL
THY. RBREELI—Y—DLUNEMICEMDOEREERTEDLSICHKETSH
TWET,

LA LRI E REE D Z2<I2IE. TR LB TIF LT OY D URBEETES
CEDBREBEMNIFEAEHYELTA. TDELIEA—H—(2E-T, Dorico DHFHEEETH
BAR—RTUTIL—RT—UFUTL— I RBHDOHDT7oH T ILELYR
BN DBHEIZERTH5HODAITHEHTLELI,
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NSO EHHEEIX. Vienna Symphonic Library @ MIR D &S3(Z, HEDHR—ILTD
ERORBZERICHRE T AOICERASNERVIMNIITICRHDLDOTIESH
YEH A, Dorico BT DEREDIITINTI ST AU ELYEFICERT DA
FERBLET . BET7UOY IR RELGRENBBMISERSNSIEICELY.,
TIHBEFERFICERESN TS YOI URFOAERLIZHZEE TH->TH. Dorico HNEET
BYOURDRACENBIZTSRADEEEE5EZFT,

ART—=UT0T—b RT—VF0TL—ME REDRT—EOTL—V—DEEZEE
ETDHIDTT ELNORT—UERTALEBEEEELT. AT—CDRTAN T,
AT—CDBANEIZEYES, TL—V—IEZOEBOECIZTHRETEET L
NoBEANDKEMBEDEILIFRTLA /A DEIZE#REIN ., AN DESADEE
BNZEIEIE Send FroRIILDEIZEBRINET . BF. ®IETDIAR—ITUTL
—MZE 2 D0 Send FroRILAEESN, 1 DIFKREDVLGLVGELDERA 1D
FEREDZECDEBAIZRYET,

RAT—=UTFUTU—MME AV RIYIIAVR T 7)) —2 K ERT—D LD 1 HFRICEEE
FTEEILBERBITHONEDONS, BLDAURRYILAVRZFTTHL, BICAV ARy
AVRDEHDTL—V—  1=EZI1E 2 DDAt a0, 4 ADHR—2TL
—V—%RRICERETDHLIG. FEEICHMINVEBDETERTEET,

ATF—UFUTL—hEER: HABOTUIL—rD536ENMDLHE TSI/ R
BRI BE. TIHIMDAT—ToTL—bDS50NVF NN EFMICERSNET,
BEDRT—oTUoTIL—eE#EA SGATRAT—VLEDTL—V—EDFEHER
(FVEYrENET), TEENDORT—UToTL— @RI 5121, TEE (Play))
» [ RT—UFFL—b (Stage Template) 1%:&IRLET .

Apply Stage Template

Chamber Strings
Chamber Woodwinds
Choir

Concert Band

Default

Piano Trio

Saxophone Quartet

FrF[JFrerr

Small Jazz

+ @ 7

Apply and Close Close
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TOaCzHNMIERTSTUTIL—rEERL. EALTEALCS (Apply and Close)l%
99 ILET,

HEBOTYIL—NMEIFATRTIZIEDT7 AV TRERSNET  HEaEOTUT
L—HRERETEER A ZEL TRTF=UFUoTL—EES (Duplicate Stage
Template) 1% 0")v0 3 5E BRBOTUITLU—MIEIKFHLWRT—SFoTL—
FEERTEET,

SATRAT—U REDAT—IOTUTL—MOMBEER T AIZIE. TY—F=IEI0L
Y —r R RDIEH—Y—LA—T B £5vHLT. SATRATF—S 94
UROEREEY,

Live Stage

@® Trumpet (B F@tIRPumpet (B Flat) 3

@ Bassuitar @ Trumpet (B F@tltumpet (B Flat) 4

® Trombone 2 @ Trombone 3
® Trombone 1 @ gass Trombone

@ Alto Sax. 1
@ Alto Sax. 2

® Tenor Sax. 1 @ Tenor Sax. 2
@ Baritone Sax.

Save as new Stage template R o

BE. TAOCIIRDTRTDAVRMYIWAVINSATRATF—UIZRTEINE T, =1
L. UTDEEIEAVRRYIILAV D RREINER A
AVRARYILAVNIERENEZ I IR T Ly vy T FEz = E/\—hyiarv
YT TCRAR—RATFUTIL—rEFERLEVESIIBEESNTNSIEES (BROMAE
DFHEEINTNSZD)
ARG LAV ININ—F v LA AR LA R TIEREK MIDI TN/ A TES
SINTWSEE

ATLABERNDA ALY LAV NETRREIT BHIZIE AV RRYILAVNESG I LTIZE
FHFEDUMBETRIVI LET . NORREVERT EFHLWMIEIZIGE /80 &
Send ENSIFH—LEDAURARYIILAVCOE AITERINET,

MK (Expand)] (BY) £1=(XM#&/v (Contract)] (B KA &) ITHE TRT
DAVARYIAVRDRAT LA BIGEARE—EITHKFERIIHENTEET,
FATRT—UDBART—UTUTU—hE R AV FILDART—OToTL— a4
TAHIZIF. BEOTOAC I SIROIDONBRLEFETT, £33 BHET. &MY
ARGIWAVRDRAT—U LOBREBICKINREZEEDETHEMNOONET BEDS
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ATRAT—VDHREESHRILEATEDILSIIRT—IUTUTL—FELTRET D5
Bl THFRRAT—UTUTL—RELTRTE (Save as new Stage Template) 1%%5")
vILTTRF—UFUTL—ME#RE (Edit Stage Template) 15 A 7O #BEE
(FEESE).

AT—UTF o T—haRE: RT—UTUTL— M RETHICIE. TBA (Play)l » TRTF

—UTUTL—h (Stage Template) 1% ERL. /ETHIRAT—ICTUIL—rEEA
THERE (Edit)1ZV)vILET . mETIRT—OTUTL— B RO AL E
ThHDGEE. FITRT—IToTL—rE4EE (Duplicate Stage Template)1%%
JyoLES,

Edit Stage Template

[RF—UF T L—4#ESE (Edit Stage Template) 1(ZS54 TR T—UEUTULET
D ADRARG VAR OAL D RIS LAV I 7I) —2EDMEEZ . REDQTOD L
[CHFEETEINEINCEREGERTELIRATELGYFET,

ARG AR TFI) =L HR DAV R WAV RKY REGHAXTRT—D L
[CRTEINFET . FI7I)—BFBA TSN RALI7II—IZBT DAV A9 AL
[FRICETRRSINET,

RAT—=UFTUTU—MIA VR AR T 7R —FBMTBIZIE. FAT7RTER/AD
I)—E1—DoRECLDTATLEIIVILTRAT—U LIZRSY I LET ERID
AVARY LAV EBNT BIZIE. Y)—E2—ZFBHRLTEMD A ARYIL AV E
ZEL (FEEBRRRVIRIZAV AR I AREEAALTIRARETAILE—LT), AT
— D EITRSY T LET, FlE W) —Ea—TI73I)—F XAV ARy LA R E R
RLT. 7o2av"—0NEM (Add)IREVEI)vITHE AT—UhRIZIURE
LAV EBESINET,

T7I)—OAVRARYILAVME RATF—C ETRSYS L TRIBELEETHIED. 7Y
2avN—DIHIEk (Delete) ITR2E91) v L TRAT—UDGHEIBRT H2ENTEET,

AT—=OPND NS TE S AV RMYILAV B O T 7 —Z DRRIFERT
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ZUYBZDEERMILNEFRA, CNERT -V EHORMyFTYYEZLONE
T ATV EDTATLIE, BRIHBRTENTUVEWNMGS (LBIROF SV T B TELR
W= [EZEETEFEA,

RCEED AR AV NERT—DITEMLTIKE, TR ENIZES RO E
T o Ff. 7O2avR—mIYYRE (Soloist)IREL &Y v o T HE, RILEBED A
ARSI AVEDHRT 1 DIEFVYRMIFRETE, EDAT—V LOREZFEETER
Fo

Flo  AVRRIWAVRD T N—TH#ERL. & IW—TE@RICERET H_LEHTE
FI AL HEBOMT, —ADABRAZRT—COEAIZ. 35— FADEE
HEERICERET B AHEIERATEET . AT—UTVTL—CEELEZY IL—
TIF. BEE—RTIL—N—ZJIL—T oI 2EIEEFERINET,

TOCIHIMIBMLI=AV AR ILAVRDERBRONIREDRAT—oTUTL—MC
LTI DONZBE. ULTOEBEIERZNAERINET,

FT . RMIGTEIBEESMEDAVRANIILAVIDHRIGE . TN ERENET,
RICTIW—TIZBTBEFESDLENA VAR LAV HDIHE . TNHMER
SNEJ,

REIC. TIN—TIIBTDEU LAV ARSI AR T7I) =D HDIHEE. Th
AERSNET,

NEDIIL—IIE, FTAVRIYIIAVCD T IL—T (EESNTLNSIGE) ICERS
., RIZTGIL—TIEENTWVENA VRS ILAVNSERASNET , SREE—KTYY
AMZEESNTWSA VR IILAV I HDIGEE . EETHVIVARM ORI ILAUR
NEEMICRT—U EICERBIN =% T, LROEBEIERIZRYET,

AR—=RTUT—h: AR—ZATUTL—ME FEDRAT—UEBE TS REDHES
EEITDHLDTYT, BHEIZESE AR—RATUTL—hEIE, FUtvhEht- Send F
YoRIE 1 DULEISXRY—ICEETHEELIT. AT—V EDRAVARYILAVRC
RIS/ L Send ENR/IMEERKIEDEYMNERT HELDTT . AT—UH]
FHEBRFADAURALY LAV RTELS Send Fror)L (BIARICIZ7EUF (Near
Send)]. #ARIZII7—t 2K (Far Send))) #E&J5H¢H. B ICRALFro+
WEFERTAHIELTEEFT, IR EDAR—RATUTL—LTlE VRTLY—
REHIDT=8. Send FroRIL 1 DITYN—T TS5 142 1 DOERAFEHEEINTL
F9,)

FGATRT—UTAV AR LA EREISE DL AR—RTUTLU—MIERINT:
[BEIZHEL ., FDAVRRYIILAVRDH AICETRI X H—SBENARINET . £EA
DKEBETIE. ZOEADNUHRABINET . EED/NNVENENIZERATES
BKIEE, AR—ZATFUTL—MZ&o>THRESNET,

O DERSADEERETIE. ZOH D Send ENRAEINFET [ZF7EUF
(Near Send) & Z77—tF (Far Send) IO AIZEL Send FroRILEEHELT:
8 AT—UDRIEITAV AR LAV N EBEISE HE. Send EFBMMICI =7 >
F (Near Send)ID{ELI 77—t K (Far Send) IDEDETHRABINET =7+
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K (Near Send) 77—+ F (Far Send)JIZ2£7%:% Send FroRILERELT-
HE.2 D20 Send (FIEEMEELEODETHRESN ., @ED Send ENYARTz—F
TEHENRMNFONFT,

HERDORT—T2FL—b: Dorico 5 (2, HERAT—UTUIL—FO—=X (TBEN

&8 (Barbershop Quartet)]. [Ew4 /\>K (Big Band)l. [75X/\>F (Brass
Band)l. EH&E % (Chamber Brass)l. [ZER5%% (Chamber Strings)1. [ERN
AE# (Chamber Woodwinds) . I&IE (Choir)]. la>4—k/S2K (Concert
Band)J. [A—% X5 (Orchestra)]. TE7/KJ# (Piano Trio)l. 49V 74 M
EZ (Saxophone Quartet)]. [RE—)LP+X (Small Jazz)]) NFET B KIIZH
YZFELT=, Hub DTFHREM (Create New) IR—UTHERLI=TOP T IMZIE, ¥)HA
BRECHEPYGERT—OTUTLU—MEIRENSLIICHYFEL, ChEDRT—OT
DTL—hE. WIThETEAE (Play)l » TRT—UT2FL—h (Stage Template) 15
LANCHILOTOCHMNILERATEEY,

Dorico [Z1E. 90 L ED AU /NILAL ARV AN EENF-a R 2— 320 nN—T D
7545 14 TREVerence |MMtEL. v —bR—IL . HE. KEBE,  R—ILIL—L,
La—TA T RAVF R EE T IVIZRIATEE T, REVerence ZEAL T, F1=I&
BFHDVN—TE=FRALT. EHEBYDYIUREEIN I EMEERTEET,

AR—RTUTL—ta#ER: HREOTUIL—rDS5ENMMOHFRTAD VAR

BT BETIHILEDAR—RTUTL—rDS5WThMABEEHIERINET,
WEDAR—RATUIL—EHHER (GATRAT—VLEDTL—Y—BDORAEER
FUtEybENFET), FEHDAR—RTFUTL—EEATSIZE. THEAE (Play)l
» [AR—ZFFL—F (Space Template) 1% EIRLE T,

Ballroom
Church
Concert Hall
Default

Recording Studio

Apply and Close Close

T xHMIERT ST L—EERL. IERALTEACS (Apply and Close) 1%
2V ILET,

HEROTUIL—MEFAT7RTICTHEO7 (A TRRSNET , HEFHFOTUT
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L—FEIRETEFREA EL. TRR=XFUTL— &1 (Duplicate Space
Template) 127y 3 5&, DT TL—MMIEIHLWAR—RTFUTL—
FEERLTEET,

FATAR—=R: SATAR—RIAVRI T RENDTODIHRD /L Send DR KIE

FRBETEET . SATRT—VD4VRDZFRKICIE, TV —VF (ML= %Y
—aoRYADI XY —y—in—Cc Bl £9)vHLET,

FarSend: Reverb

Left Pan: Right Pan:
L100 R100

Near Send: = Reverb

Save as new Space template Fallback Y Position: 0.50 : Click Reverb: = Reverb

Cancel OK

FATRAR—ADEREITS VT ILTT, [E/Y (Left Pan)j&H/1> (Right Pan))
DEIE. SATRT—LDEEDIHITHE T DAV AR ILAVRD N DERKEETE
#L.=7+t>F (Near Send)|&TJ7—E UK (Far Send)|DIEIL, SATRAT—
DENEDIHIZHRE T DA Ay LAV MIFEESNS Send FroR)ILE, TDFrY
RN —TAV T ESNBEBNDEEZEELET . AT—2M 2 RAZEROEEDIS
FRICEEE SN I=A U ARHILAVRD /A E Send DIEX., T ThoDIEDRKIZIRE
BIEICHEYET,

[ Y L& (Fallback Y Position)l(&. RT—U TV T L—RTEBERSNTLVELNA
DARYILAURD T IAILEDEERE (EEMAE) ZHEEL.0 (RT—YH1A) &1 (RT
—D%A) DEDETREREEINET,

[41)wy%41)s13—7T (Click Reverb) ][, AbO/— LYy I DIFH—~DHEAIZFH
95 Send FroRILEBELET MDAV RARYILAVMIFERT 2D ERLY/N—
T AME®D Send FroRIL, FEAHFERALGNWIENSBIRTEET,
[—7+>F (Near Send)1&M 77—t K (Far Send) %, S¥H—DED Send F+
DN EFERTINEEIRTEET N SATRAR—ZADAVRIMLINEDF o3
IWEBEERETDHILIETES . SXY—D( RO TERETIDLELHYET,
FUOFILDAR—=RTUTL— R T HIHE(E. FTIFY—0D Send Frox
WIZERATEZTSTAVERTEL. SATAR—RAIAVR I THREEZITH>THL. TR
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R—ZRFUTL—rELTIRTE (Save as Space Template) 1%y 7L T RAR—RF
v FL—hE4RE (Edit Space Template) 1% A 7 OS5 ZREEY,

AR—RATUT—EHmE: FATAR—=RAIAVRIOMBAR—=RTUTL— 2R ETH
BEY. [BE (Play)l » TRR—ZXFUTFL—F (Space Template) |5 4 705 s
HERDAR—RTUTL—rEERTH5HEEL. ALKTRAR—RTUTL— M EmE
(Edit Space Template)1# A 7O NRRSINFET, COFAT7AT &L T4 TAR—
RAOAVR D ERERZRIERLTEN. #4705 LEICAR—RTUTL—hE %5
ETB=HDADEIEBMESNTINET,

HEH O Send FroRIL: SXH—(Z FX Send FroRILERK 8 FYoRILETEMNT
EFBRSTHYELZ SX Y —DAU R DY—ILIN—DIFX+ 1% 9993 B L. FiL
LY Send FroRILASEMENET , TFX-1201)v0F 5& Send FroRILHHEIFRS
NETH. HIBRTESDIEAHD Send FroRILEZITEOT, Hind Send Fr
FILEBIRDPDARIDNEMCLGYET, £ SFH—0D Send FroRILDIx
— A —DERBNEFINTLET,

SXH—DFVYURILBEER: SXY—DF ORIV BEEBRTELSSIHYELZ. T
V= FRIERIALEE D4R ORI XY —TII— A —DTIZHAIFroRILIAN
WESL TV, FHILWRRETIEAALT [Return] £ LT, EELARBSH
9, BEIET IAHIMNIRTIESIE. TT42—DABEHELT [Return] 1L T
{IZELY,

HEERFDRAR—XTUTL—k: Dorico 5 12, HERFDAR—XTUTL—b—= (TFR—)L
JL—L (Ballroom)]. [#% (Church)]. la>¥%—k7k—JL (Concert Hall)]. L0
—T 42 A2V F (Recording Studio) 1. TRa7> 45 XFT— (Scoring Stage) )
PMFE T BESITHEYFELIz, Hub DIFHRIER (Create New)IR—I TERLT-T O
DO, DR E CTEUEAR—ZATUTL—AEIREN B KSIZEYELT,
NEDAR—RTUTL—rE. WTFThITBLE (Play)] » TRR—XFUFL—k
(Space Template) 1/ 5A)FILDTADIHMILBERATEET,

BETUIL—h BETUTL—EESHTE AR—XATUTL—IBEESN TS
BAIL, EEHEINIBETVIL—FO—EELTIhLEZHEINET,
RIFETOBETUIL—PERHADE AR—ZRTUTL—rb—#IIHEAAFEN
T.[B4 (Play)] » TRR—ZRFFL—F (Space Template)l[ZKFREND LS
BYES,

BEH O Send FroRIL: SXH—(Z FX Send FroRILERK 8 FYoRILETEMNT
EBLSITHYFELZ SX Y —D1U RO DY—ILIN—DIFX+1E 90T B L. FHiL
LY Send FroRILASEMEINET , TFX-1201)v0F 5& Send FroRILHVHEIBRS
NETH. HIRTESDIEAIHD Send FroRILEEITEOT, Bind Send Fr>
FIVEBIRPOARIVDNEMCHYES, £, S¥H—0D Send FroRILDTx
— A —DERBNEFINTLET,

SXY—DF VORI BEER: SXY—DF v RIVBEEETESSIILBYEL=, F
V—UFRIERIALI= 4R VRADIX Y —TII—F—DTFIZHAF Yo RILIAN
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WEZTILY)IL #HLWARTEZAALT [Return] 9 2&T, EEMARBEN
FY, BEZET IHILMIRTIHERIF. TT42—DABEHEELT [Return] ZH#HLT
fEElby,

HMITOC T ONET IAINMDARAT—TFUTU— R ERAR—RATFUTL—: R TOST

HEEBIRT HEE, TODIHMNTFUTL—MIEESINERT—STFUTL— A H 5
BEFETANAERINET . BNMGEIE. RERTEDIFE (Play)IR—CDIF7+
IWEDRTF—IFUTL—b (Default stage template) I THEESNTWVBRT—CF
STL—bhMEREINET

HRTOS T OMIBIRINBZAR—ITUTL—ME BETUTL—k, TASTHR
FUOTL—HMIEHEBINTVWBRAR—ZXTFUTL—FDOEIR REBEHREDAR—RATY
TL—rDEEE UE3IDDSENWTIMNZKYRESNET,

REZRTEDIBAE (Play) IR—U TIRAR—ZTUTL—rD) LEE (Space template
override) 1N R ESNTLSIGE. FRTOD I NDORIBE. BLUBETVTL—
FOEANBEREE. BICTFDAR—RTUTIL—MIMERSNET  RESN TV
WMEE.FRTOCI IR IOV TL—MIIEESN TLWSAR—X
TUIL—tD . BETUTL—FOERBIREDEE T IL—HIIBESA T
BAR—RATUTL—rAERINET,

YN—=T .2 TLyH—  ZOMIZOVWTHBEDEREEZITEL., BITFXTOTAY
IIMIERTREEIE. FOREEAR—RATUTIL—hELTEEZL. BERTED
[RAR—RFUTL—rD EEZEF (Space template override) | T:EIRLET,

IHRTLyareyvTEIN—hyiareyr: THORTLyarevIEz =/ —hyi 3

URYT TR TV TEERTAIVRRAVMIBEDRT—ToTL— bR R
R—RATFUTIL—rDEBREEERT EINEIDNEHETEET,

FERTH IV ARIILAVNEESATI)—DEEZF > THRESN LD THNIL,
RAT—UTU0T— BRI AIBEIBEADBYERT A £2534T3—IZHRBED
HRESHARBINTVIBA X, AHRICAR—ITFUTL— 2 EATIREF LR
TL&S, fz&Z X NotePerformer (£, RTLAMIERY/N—TF#HBICNETSHE
Do, TIHIETIERR—RTFUTU—FORT—ITUTL— ALV EIC
BoTWET,

EvFDimERHT

Dorico 5 Version History

Dorico 5 Tl&. FREDE Y FDEHERERF 7 IILTV X LIZKY A AT —HEKYKRIE
B, ABERENEBESNET, Dorico DIBFED/ =23 TlE, BA3IUT 05
AFIVRITHMEDSUT LEEFEEHTEa—<F AR 1HE . BAEEIEMMIZYT
BO0EHSCHEENT TITEHINTOELz, EvFDOERERET L. ShdnELTE D
BEFIRRL . KUZa TV REMNTTEHEDTT,

EHDI2—IIrUE TIL—XDOFTRHEVNELYENEEZDLRECT IO E
ATT . LAL. BRICZATEYFOLRIZRNWDLI DEEZ LIFTUKET T
T+HRTY . EFDIa—V IV UKL MR EZ TR LIZMA, RED
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ZIEDEELGDHERIE. B ORREBTRAGCTNEGLLENGENSLHYETS,

Dorico [£. £FDI1—V v AR THIEEMNLEIL—XDWWEARTZBOEILET
2aLb—hL AATA—DERPTREBEICERT LG YRRENTESR
ZRELFEY,

AOT4—HOEYFOEHEBIL, MEYF LMEFEYF . MAMBEERFDI(IVYT .
ERETAL—2a B E  LDADEL— AT AT HEIVWTHESNET,
DITYMIFERTEITERIZETINS =D BELRLERDBFIE (LA Rk
WAV THEGSZERTHNIL), ERHSHDERE-DBZIL—XERNTIE. E
CARTATSAOD—EELTHRONDZEEHYER A RIITHZVIA D ARHILAY
FPDBEE. AOTA—DRZEHET IRICKMEINIDIERERD—BLOEFT
ER

EvFOmE@AIL. R TOP IO TIET IAILNTERTI A, Dorico 5 THBAE
TAHRICRBINEREITELEIEILZELEIEEEITDEO. BEOTODIIRT
(FERZIE->TLET,

EvFOmEERAICET 54 Tavid. BEA T ar DI@5EEEE (Dynamics) X
—2Dlea—3F4 X (Humanize) 1o avIcHYET,
[EyFDEREBHIAZEE A (Use pitch contour emphasis)]ld. £&k&L TS
DIT VA UICTENEIMNEHIFLET
TSR DOYLMEE (Scale effect by)llL. TI7HILEDLARILIZH L THEEE
BTEET,
R LDABICHTHEILDZKIE (Maximum change to written
dynamic)J (. BBDOLARIILE EFIZELSEONIEREFREELET .
[ShERDILHEE (Scale effect by)1ZENTZITRELLIZELTE, BEFLAIL
DEENZDEEZBADZEIIHAINET A MEARED LRELSHERTEL
N)LIFE 1.5 TTH., R DHEHESE (Scale effect by)1HY 100% DIHFE. LY
FTHICTELHRORKIEL 1.25 375BITHYET,
NEDEIEBAROITIRTLY 3 IvTNTLEETEHIELTEET,
EvFOEERRE L. TIAHIEDRBLAIILE LEIDLEIFTTESTERISZZELHDD
TEEMBETY, NI AOTASAVDLERETRICEHLE TRL—XIZHITT
B1=BITMHETYT , 2LH AATATAVDTRICEYELDEDIE. ERICL S8
MEYIFDMNENBDIZBYET

HDEE: EvFOWmERFIL. HDBRBOBBNEL—IF A XERBEDRFOEIL

ZH1691O . FRTACIMRIC. ThoDBFEREED T 74 LNIAESh TL
T HEBDHRILBRENHDER L. EEAREITLDIGEELHLINMLAFE
Ao

EvF OB L B/EBITERICITEELLEV O, BEDOHDB®RBA T av (L,
HERITHLTIEEBTEERIYBMEICRETHOLRMTYT, TD=H. BE
AT 3> DIRFBEES (Dynamics) IR—C DI EFF DT (Note Dynamics) 1%

11 Steinberg Media Technologies GmbH



@ steinberg

2avIZH BTN EE (Beat stress)|F T3> Tl EERRERLE|EERERERT
Al 2 DEMERETEDLSICHEYEL -,

E#kIZ. TEa—<F 4 X (Humanize)l o3> DI EDEBEEL—F (X
9 5%|A n% (Humanize written dynamic by n%)14 7 a2t B SRR LEE
BREFTIHRDEINFZETETSLIICHYFEL -,

Groove Agent SE

Dorico 5 Version History

Groove Agent SE [&. Steinberg DY) IAT4TRZ LY IR DIV )—RT,
4 E&YIDorico 51ICRMRENET  NILYDDTILTYIRARZTSF TiRESNT=. ¥
SOYHBYN—TFooN—2ELTIA—RAT14vIRSLF YR The Kitid 1 /13—
IVMNUIREREIN. 2 DDIAIRO LIV LEIRTEET,

Groove Agent SE (&, Dorico 7OV /DB RERFSLFYMBET/NARELT
FRATESLITTHLL T ISRDRADFRST—HEEL T Steinberg DEFL
IVOZTMNIYIALI=. 400 LLED MIDI RS LNZ—2pUREFSNTLNVET,
Dorico D#it%EETH S MIDI MJH—EIBEFERALT/N\Z—2 2 N A—3 528 B
EE—FTrSYIBEBIZRSYI TURROYTILT. BEDNI—ERAAEE ST
LELTEEY,

Groove Agent SE DAV AR—JLIFIEETT A, BT THLET,

HEBOBYETTL—k: Groove Agent SE MA UV Ar—ILENTWRES.

HSSE+HSO+GASE (Pro)J] (Dorico Pro ® &) &THSSE+GASE (Elements) |
(Dorico Pro. Dorico Elements D& ) M 2 DNBAETUTL—IAEBMTRERINE
T, NbDBETUTL—HE, TADIINMIRS LEYbEEBMNT SEE(Z Groove
Agent SE # BEIMIIZEHRARAHA . NESALTz Studio Kit DY IUREBAICERT S
H DT, Thid HALion Sonic DHFEILTUYDZERS LY KYEERET
NSITAITBAEYIURERBLET,

Groove Agent SE Z#5&3AE &, Studio Kit EOvI/AVM)—DIE—UNEENT-
INYFHREBMNICEAAENET, £ MI—UNRIETBD(E MIDI FroRL 2
D/—bDHIFBRESNTVNET A, Th(F/E—2 D) A—IZFERShBEyF &,
Studio Kit DY R—rF LR ERFEEZD—BOFHLHS>DERTDH-HTT,
Groove Agent SE T/N\A—2ZBA T 51-6HIC MIDI M)A —BEEERT 555,
WEITIGECTEBMIC MIDI /= F Yo RIL 2 [TEINET,

Groove Agent SE IZEENDFYMIEUYRTOvINEFR TS, TOD
TOMITIRSLEIRDAURARYIILA R EEBMLZY ., FSLAEYMIEBMDO A X+
HILAVRERTELIZYLIZGE .. TOAVAMYILAVNEBE T H=OI2 1ZED
HALion Sonic FS Aty OZDMDESEITERO Y IUENLFATELLON
SARAENET,
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Dorico 5 Version History

@ steinberg

Dorico 5 M ¥ EIFFIZ Groove Agent SE AU Rk—IILEnTWBEE X,
Groove Agent 2T ABYIHBET UV TL— T I4ILEDBETUTL—REL
TEREINET , Dorico 4 URTID/N—23vh D7y T T—THIGE . BEDT
THIVEBETUTLU— M URIDN—230 TTIAI ML TEIRSN TLOVISEED
# . Groove Agent RIIEDBETUTL—IARIRENET ., ChiX. BERTEDIE
4 (Play) IR—C TV D THIAERIRETY,

Groove Agent SE #F & Tt vh7v7: Groove Agent SE BNERESNT-BETTL—

ZHEALTVVEWMES. TP VMNTFHTRETIVLENHYFET . FT. UT

D FIET Groove Agent SE 5y IZBMLET,
BEE—FICUYEZET,
£V —>TIVST & MIDI (VST and MIDI) |/ SR JLEEIRLET,
VST 412 XmILAVE (VST Instruments) | 293> D TFERIZH BT I3
DIN—D R EV)VILT IVIIZZEDIUN)—ZEMLET,
SYINEDIVRN)—DA=a1—Mm il Steinberg]l » [Drum) » [Groove
Agent SEIZEIRLT. TSI AV &HHAHET

Groove Agent SE D74V R L. LUTD 4 DDAV ITYTIZHDNTNET,
FokROyk: DAURVELICHEL., FAHARAAZFVDBRINRRESN,
ADFYhEFRARALERL, FYMDFEAAAFFIZEET S MIDI /2—2%
AR MNEIDNGEDERELERZITHZAFET @)
FybIvD: D4R IALITHEL. EARENTVSFVLERIRLET,
(Groove Agent 759 4V DEEMTIE, ZZITHRK 4 DDFYLEHRARAD
F3 A%, Groove Agent SE Tl& 1 21+ TY,)
INYREI IV D4URIETICMEL, MU RR—kavka—iL, JIL—
TRAY RS LNYEDBREBEBSNTOET , /NyFE 23 BNTA Xy LA
>k (Instrument) JE—F D EE (X, B/XYRBNFIYRHRD AU RRY LAV 1
DIZxIGL, [784—> (Pattern) JE—FDEE (X, HE/N\YENELZ /18—
[Zxt i LET
wERT: V1R OATICMEL. TRE (Edit)). IS%HY— (Mixer)l. (47
23> (Options) IDER—U MRRENET,

RERTOALAIZIE 2 DOBERGRIVHAHYET @ (F. V1 FOETAHREIC
WERLCE7 /F—R—F&#RRLET B L. 71RO EERIIZHEGRL T MediaBay
INRIVERRL, FYFDBEROFEAAAEITEAET,

FIREHRAADIZIE, FYCRAYRTER YNGR ED )V ITHH., FYRITVIDZERD
YRDTDIRNILES)vILET , IMETE MediaBay /A RILBARTRSNET,
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[ JON Load Kit...
The Kit SE.

Alternative/Indie 3 | Acoustic Blues

Blues 1 Blues Rock

Pop 1 Classic Rock

Rock/Metal 5 Funk Rock
Hard Rock
Heavy Metal
Indie Rock
NuMetal
Pop/Rock

lame Rating Properties
» Binding Blank Pages *k%k

a Highs And Lows Of Life *kk

N
o
O, Feel How Sweet It Is wokk
o
O, Init The Kit SE *kk

« Keep Dialog Open

NI EBDA=2—F DYy L THRATESFYCDOENSEIRTHM . [TRT
(AIZED2)vILTETRTOF YD /Ny FZ/ARILICAALET , Groove Agent SE
@D MIDI NA—2%FERT 5568 1E. B LADTFYRE—BIZ/IRI—2FRARAD
(Load Kit with Pattern) /R4y (@) NERICHS>TNBIEERERL TSN, Fy
FEZ TV ILTHRARAAFET,
FURDFEARAENTZRIE. UTOFIBTTST 105700z VMADRS Lty
BRI OIBELHYFET,
BEE—FICUVEZES,
EI—2TINSYDA4 20 AR5 — (Track Inspector) |/ SR JLEEIRLE T,
FoYIOBBE TR S LEYRDISYIEERLET,
ESYOA ARG B—DINIL—FT42% (Routing) 193> T, TS5 (A=
a1—h 5l Groove Agent SE | % E#IRLET,
B 2509l T  TURRAVFOBRES AT O EREET .
IVRRAUPDHRET, FrorL 1 OT/S—hyiar<yT (Percussion
Map) 15Tl Groove Agent SE Studio Kit1%:Z&RL. [OKIZ5)vILET,
CNT.FSLEYrDERICEEELLERFET ERLEBETVIL—MDTI4LE
DESLFIrOMHYIZ, Groove Agent SE TEBESINEELSIZHYET,
Groove Agent SE DERAZDFHMIZOVLTIE, ERHDARL—arv—aF L%
SHRL T,

MIDI /N3—>%{FF: Groove Agent SE IZFEAIAATZF YR MIDI /33— EFENT
WBIBE. /Syktsoas Dl 88— (Pattern)IRAL DFC EIZINSHEALL S
DEBAIT—E3—NRLILET, ChEIVvITHE Yk aVIZUTDK
SIENR—2 DT )RR RENFT,
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@ steinberg

NEA—=DEBHITENTHEY., LXa5— (FE AL )) NE—DFER, D0LIEE.
AobOEEE. ToTAVTERIZHELOTVWET,

BENVRDBELAICIE. SO/RF—2FRN)A—F 126D MIDI EvFHRRINATL
9, nbd MIDI EwFIE, =KJL C (MIDI /—Fk 60) & C3 L9 H1EHIIZHE->TE
RENFET , Dorico THERERILIFIL C DEFIZHSLIIETET HEERTY, Ihld
MERIEELE (Preferences) | DI £ (General) JIX—Y TISRJL C (/—h 60)1%IC3]
[ZERET HETITHEAET .

BEE—FOMYIOBE., FEF—I T3 —DITEBRIT13—I2/\3—2%F
T TORROY TG HE IRF—VFRATITHRARDET  FULMEBARA U E/ 4
— DERBUEERLET,

NA—2%FERT 515 1 DD AEIL. Dorico 5 D#FH%RETH S MIDI M) H—5E1E%E
FRALT, \3—2 % ) H—FBZETY (TERSH).

MIDI ) /i —5E1E

Dorico 5 Version History

F—IF4B—TIE. MIDl A2 FT4=aF7RAVEO—5—0DfE, EVYFRUR, TURE
BipE%, BRI 2RA7ICHEBEEATICHATEETA 1 DREFTEZLOAA,
AATICEIRENGEVEFDOHATY,

Dorico D#F#ERETH S MIDI FJH—FEEL . EELI-SEFE TN A, RATIZRTRSN
BOERFOHNBEERTHODOHEETT,

Groove Agent SE ED TS5 440, TGuitar HE D/IRE—2R—ZD AV AL
AURT,MIDI /88— FN)H—TELRAEFIZERTT . APDORST—HPF4YR
FDI=DICEEEERTIOTHNIE. TNENDN—IEZELICESLIFILEL
HYERA HOEBREVNDOIDY X LIZEDFa—, FLTa—KREEEZEANIL,
HEIFER T TNSIET T LML, REMICABDIA—D v k> THE
BINBILIFHWNREDERICRDHEMET hEBOT ZEELIELTH. H5
BEUTZIVEYIUEDRBLIMES ., NI—UR—AD T35 1V IFEEOHHITKE
BREFRELET,
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Dorico 5 Version History

@ steinberg

MIDI k) A —4EEZERk: MIDI ) —fEiE L. L TOFIETERTEET,

/— EBASELEEERRLETS.

[EC&% (Write)l » TMIDI k1) 7F—%Ei8iZ £ X (Create MIDI Trigger Region) |
#8INT B, a—khykF— [Shift]+[0] (£0O) ZEALT. MIDI k)H—
EHORYTA—N—FRAZTFET,

BEEIEDS 1 DFELIFERDO/— EEFIATANTHH . MIDI F—FR—FKT
;EZEL T, [Return] #BLEY,

MIDI FUA—fEEE AN A7 EICER SN, BERDOTICHEN KB D/N—(ZIF, FEER
TEZRIND 1 DFELFEROEVFEARTEINET,

Ry TH—N—HFRANTULSMEIE, MIDI F—HR—FTEEF-FIMBFLMETLES
L% &L T, Groove Agent SE D/ \E—UR—ZAD TS5 A0 DEESE /58—
VERETCEFET  ARYTA—N—ZRAVV-REBTERLLEFTONE . £ITES
LIzEEPHEE LEET 520, [Return] T ETIHAETEESTEZHAEET.

ANOYTA—ZEE: MIDI F—R—FZEALTLDIEE., SHIV=/—tPa—kn~AOY

TA—EYFDYRANMIEMSH, FEIMAIZRRTESNET, MIDI M) H—BEIZE R
SN/ —MIZDROLTA—TEEINET . AALTA—DIEESNEMES . 1)
HIREME (™ DFAFIVIERSLTRE) AMERSNET,

RYTH—N—ICANTHRIE. RO TA—EZZATANTHELTEFT . AA
T4 BREDEYFDHEIZ 0 ~ 127 DELF M ANTIEELET .

MIDI k) —fEEZ#RE: BEFED MIDI M)A —fBECESZSND /—FPa—KEEFET S

[ZIE. Fn%EERLT [Return] Z3L., Ry TA—/N\—FHERLT, A TESS
BAHLLN/—rOO—FE A4 TANF-IETEELTH S, [Return] L TEES
HEELEY,

MIDI kA —5E8E &, NV E—FEE S . RS Y A /R, O—FRESDRTF/ERTD
FEEGE . DEEBERICLSICBIMELE T, Bl ERIRLIzLERTINDSATB D/
VRV EFEALTEBPRIOEEREZTEO L. BED [AIt]+[]/[—] DI a—th
vhEFEALTEE O, [Shift|+[Alt]+H[—]/[—] THREDREDEEE1THESIEE
TEEY,

MIDI b A—fEiZE R R: MIDI Y F—fEE (X, (FIRIE—FDBEY—2DNER

(Annotations) 153> Tl T3 % &R (View options) I FT v IRy I REH
HMIZLEWLRY) RIS ER A PR ECEEELICRRINAFEFT N . TEa—
(View)] » TMIDI M)A —45E1k%3#%EF (Highlight MIDI Trigger Regions) %Y
AZBHIET. RNFERTENYEZAONTET,

2RJ)L C DIERI: MIDI M)A —BI IR REND/—hE L. REBEZTEDIEHM (General) |

R=II1ZHBIERIL C (/—b 60) (Middle C (note 60))1DFA T avIZHEWLNET,
Groove Agent SE M &3, SRIL CE C3 EREBITEITSTAUEFALTNSIES.
ZDATLav#EICINIIRET S EE. MIDI NJA—SEEICRRENEFHV4—TF
£ & Groove Agent SE DRJH—/SYRIZRRESNDIFVF—TBEEN—HT 510,
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@ steinberg

ERTY,
RUSTEE

RIFEVTEE A —TA4FT—T THREZTHO TV =R, U—LEF B THERS
BT TBEANYR ETT TR SE TREREETROBEN. CTURLDEST
HOCEICHETHEETY . REDYIrYIT7 T, RIFTEFA—H -7
RERSYY  FE 3T RA— L EERALTREREEITRIC, ATAFERAIC
BREAETA—TAAZBETETOCREEKRT L5 YEL -,

BRIV I DI T7TH RVSTHREEILBERGEBZELHYET &I
Z.RHELETITEONBHEEDELEIL. TOAINF—TAARELIFIKRELELRYFET,
FTABHR ToHUTILERTE 1 DDAV ARYIAVPTHEEDRA UM THEEIC
RETE, FELERSTHREICHLERAMEICTEFETES RITTBEHEELHT-
[Z Dorico 5 IZEASNZELT =,

RUSTBEEEMNIL: BEE—FTIE. U TOWTIAALDAETRISTBEEZEMILT
FFET,
B4 (Play)l » TROSTHE (Scrub Playback) 1%:&1R
Y—ILIN—DRAIZTBEREIY (TUoRDHEABLEELNS D RR— D4R
DERGRA DORIZH D) #HHIE
[Ctri]+[Space] (Windows) F1=[& [Alt]+[Space] (macOS) #L#IT5

(B4 (Play) I A=1—F =& Y—ILIA—DREVTRISTBEEEDICLI-EES.
[Esc] Z# 9 h. A=2—IHBE DI RYSTELE (Scrub Playback) |1ZH E:EIRT 5hH.

Y—ILIN—DREVELSI—EE T I, WTIH DA ETHRMIZENZTS
EFT.AMTHYRITET , —AH. F—R—FLa— AV TRISTEEZFHICTS
58 AMNEDIEF—EHRLTLSEEITTY,

F—R—Fla—bthytzERTIE. TORBETFEICRIVSTBELZRETEDS
DT, ETHEFTY , (BRESTORIE, [~] F—ZWTEBMELESN, F—FHLEET
TWBRERETERIENGENT AT LA —FHIZIERTRITES, AV REVMIRITLE
1—EREIFHRDEDTY )

RVZTBENENGIEE . REEHE L TIYVARIVE—EENT LRIV E2—D
RERMRAE—H—IZBY IV A RAA—EBHEMETEZROLTVSEFRA
ERBEINET, ED=H. IVARSAEA—EFHH T T T, ROI—FPFHID3
—NICESDFERR(IVT THRETEEY,

AVRRYILAVREYDIZT S DR ETIH, YORRAVE4—EEahEHEBIZETS
TRTCODEFNERINES, IVRARAIVEA—DETFIZHEIIVRRYILAV D H
DV AIZT HIZIX. [Shift] A F T, [Ctri]+[Space] (Windows) F 7= (&
[Alt]+[Space] (macOS) D a—thybEBLENLGRISTBEFTEIEE. XY
ARAVBA—EEDEZAV ARG ILAVNEYOIZT HIZIE, JBINT [Shift] Z3#R LT
BDHENHYET,

EMEF ROSTBLER, EHETFLGE . VALLONEIZBSRVWEFIIBLEShFY
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@ steinberg

Ao
JE—hk: JE—FDHIREERISTEETSHHEIE. VE—FOFHHEITECHRIZEB
THAEDETEEINET,
AR ILAVRI T 43—

Dorico 5 Version History

Dorico [Z1% 600 L E DAV AR ILAVREL T DT —BR—ZAMNHY, TOT o
FATAVRARYILAVPDRT, SNILT T, BEAEEZRETIBUNEZRINT
WET . CNITIFEBRINL, Bl EESSLUVEREOTE. EEROH. ERRD
. TIHILEDBEHESLRESHLEENTVET,

Dorico 5 TlE. ChHDEREZRELTHLOA VR ILAVMNEERTEA 51475
I)— (Library)] » T{2 Xy JLAUR (Instruments) |15 4 70O BFFf=ICEAShE
Lo ERLIEABTOHBEDAVRRILAVKE, RELTSEDOTOD IR THE
BTEET,

AVRARYI AT TA4R3—ZFHG AV AR AVRIT43—ZFKIZIE ULTFD 2 DDA

ENHYET
BREE—FRT.R/ETEIAVAMIILAVINEY ETONE=TL—Y—DH—F
EREAL.T...IZVUVILTAV R AR DAV T X RN AZ A —FBNT,
(AR ILAVPDEHEEZHSE (Edit Instrument Definition) | 2:E&RLE T,
ARG AT T 42— FE BRULFZAD ARSI AV IDIRE TE DK
REICHRYET,
542751 — (Library)] » T {2 XbyJLAVE (Instruments) 1% #IRLET,
AAT7HNTAMNBIREN TSI —FRINCHIERICHIET DAV XY
ILAVRDEREN  RETEDRBIZHRYET,

TADIIMM ORI AVRETGA TS — AV ARG AV AV ARG AR IT4R—T

(X BAVARYILAVREILATRERREINDDIE 1 BT ODHTY, AP TINTEH
EDAVARY AR EBLTHNERENTNSEE ., EAIOYRANMIIELRIZT (in
score) IEEBMLTRREINET . TDAVAMYIILAVRDERICMA-REF, 7O
CIOMADFDEZATDAV R IILAVNT RTIZERASNET,

=R IE, KLKHBBIELT. TASIINI 2 DDNAF )N BBIGE . AV ARy LA
URIT4B—DERIDYZMZIEIViolin (in score)1&lLYS 1 DDIEENRRSN,
EFEABETOCOMADOEADNAAYUITERSNET,

TACIIMIBE— DAV RMYILAVEDEHY  ENENERICEFEMADIDELH
BBE.EFTAVARIIWAVRITAR—TAV AR AVREZDFH/NA—DaE1E
BL.REE—FTIAVRAIYILAVIEZEE (Change Instrument) 1Z{#E AL T, %
L DAV ARYIAVMMIFN—Da 0 FBRLET,
TOCIOMIFEEADTOWENAD AR ILAUSTE, AV AR LAV R I T AB—TIT
BoZERIX. O IMDIATI—IZRFINFET . TDHE CORELIzAY
ARYILAVRDEREERT DA RARILAVNEER T BE., £IZITHO TV IRE
NREEhFET,
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@ steinberg

AVRRGILAV D ERICMATRECHRDARAMYIILAVEDERESEDOTO
DO THATESLSIZTBICIE, 7o2avN\—DITI4ILLELTRE (Save as
Default)] (B) 245)ysLET, E7PAAVNPRIZEDHBE BIRLIAV Rk ILA
JrDEBENLI—HY =S4T —IZEHFG I UBETRTOFHFHR IO H/MTHA
TEDEIIHYET,

ARG LAV A EEDTTASTIRD AV ARG VAV D HF T (Show only
project instruments) I7R32> () 790 FBE ARG ILAIRILT DA
TAIEA—N, TOCT MDAV AR LA D HINRTENDKIITHYET,

FIz ARG ILAVR)RME, T7721)—TI4)LA— (Filter by family) 1 *=21—%
BERALTIFIV—TIANE—FTHIEL AV ARYILAV N A EBDTL VAL
AU bEHEE (Search instruments) D A AMRIZA VALY LAV NE D EERE [T —
BEANLTIAINAE—TTBHIELTEET,

[V RRY LA RESRESE (Edit Instruments)1Z A 7R #4707 (XD LS55 E T,
UTFDE I avIZREIInNTVET,

Allinstrument families

(A ZRYILAUR (Instrument) 1532
(AR ILAVREYH—4% (Name in instrument picker) (X, 12 Xk5)L
AUREVA—DFROFITHEAINSLHTY .
[/X) 72k (Variant name)] (3. AV ALY ILAVNMIE#-D/N) T — 3
UNBBGEE . AR AVREYH—D—BREDIITHEASNSLHITT,
[/R) 7o rDEBA%E) vk (Reset variant description)I/h22 %5 w99
B&E.TIHIMDIEIC)EYRENET,

Dorico 5 Version History 19 Steinberg Media Technologies GmbH



@ steinberg

[J731)— (Families) IDFEAHLHIZIE, AR IILAVIDET HT772)
—INRIRINFT . BEILFLETLEAFLEAN FRDY)—XTIEFESHN
TWEY,

AVRRYILAVEDRTL Y EBDIGE . [REF1a—=V T %#mE (Edit
Strings and Tunings) I R2VDRIREN, VU vIT5HETLYRERDIZA
DBEEDITA3—DBEET,
AVARRGILAVEDITER T VLD A X ITEBXVLEHE (Edit
Percussion Kit) IRV ARREN ., Vv I T HEITEBOITERTINDE
EDITA3—HFHEEET,

[s%S~)L (Staff Labels) 1 £2Sav(z(E, BRSAILIZFERINIZNEADS
BOBRAEDENRRSNET  WETDICETAURYIILAVIEZEHE (Edit
Instrument Names) 12"y L%ET,

[k S EEC S (Staves and Clefs) 1 zo 3.
&R DE (Number of staves)1lE. 1V ARY LAV NMIT I4ILETEIY BT
LNHERDBERELET,
MFERIBDOE (Number of staff lines)|lL. 1V RS ILAVMIET 5K
[CRRTDERBOBERELES . ERBOBELEELTH, A1V RARYILA
UMNEABEERBELTHRDONET , Dorico (&, #&A5 R TIXARGERZEA
TEHLAEEREEBEZERICIEIYR—ILTVERA, CORTEFEERIZICSE,
BHOLHERICHEDZEFEEBLTESL,
AVRRGILAVMIEHDERNEVATOATLSES. [INFRD R/
(Span of barline)I TlX. /NET#ET (LMD TA) DRIFEIEREIEETEE
ED
E#kI=. T XEEMD R/ (Span of bracket) I Tld. EDiExRE KIEME (T
PRI CORCHEIRETEDLEELIC.F 1 BIlCEDEEDORFINEFEHT
BMIZDNT, TKIEW (754 vhk) (Bracket) 1 ZE =M EN (TLAR)
(Brace) | % EIRTH_LTHEETEEY,
IFEZRDER (Vocal staff) IZF#ICTHE. MEADAIFMEE LIF51=0IZ.
VR E CTHBESINERD LICR RSN, BALE 1 LT IL—TIZETS
BEELI-ERE CREERINS/NIROERIBRINDLIITHYET,
AVRARGILAVMIEREIN=T I+ IV DEBRILIZ, TBRALITILDOE
EBEE S (Clef for transposing layouts) &, TNEITELBIBRAL AT IR
TRBEVLALTILDEEES (Clef for non-transposing layout) I Z{EE.
THETEET.

(%8R (Transposition) | 723> TlE, AV ARSI AV DR T HEFELXIEETE

F9,
MFEEE LEDIFIL C (/—F 60) DEBRDFEE (Written middle C (note 60)
sounds as)ll&. EEDLAT I TDAIF—T DBRAERELET, =EX
(£, C4 #3F)L C LT HEFEFEALTNSET BHL, F4— (RBIEREE
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@ steinberg

Y 1 A94—TF) OFAE. ChiFTC3IZH/KEL. Evan (REERTEY 1
Fo48—T L) DIFEE . ChIETC5IIZHRELET,

[FBEAAT7IZEITBIRIL C (/—F 60) DFEF (In a transposing score,
written middle C (note 60) sounds as)ll&. AL A7V TOBRAZIEE
LET, =EAIE. Tt C4 EIRIL C ET 4L, PILMNFIV Iy (BT
RELFVUR 6 ET) DIFE. CNIZTELIJIZEHZEL. AVFI/NRIF L
(BFEREBELY 2495—TELLET) OBE. CNIEMBb1IICERELET .
[AE%H (Uses key signature)lld. 1> ALY LAVMIABSERTT S
N HASERTLEVDDYICTRTOBTFICLEICELTCEERESERT
TENERELET,

&#%IZ.[EFE (Range)l /2 avTlE AV RARYIILAV M DIRETH & LRE T
FIRETEET, CNIETEa— (View)] > TEFEAKRFDHS— (Note and Rest
Colors)] » I'EE55 DEFFF (Notes Out of Range) INBE# G ESHRAINET, [E
#F1 (Standard range) &M L& F18 (Advanced range) 1D 2 DDI#ET
(End)]DEDMIZHAHEYFILREV AR TRRSN ., [ L#EEFHE (Advanced range)]
DMHRT (End)IDELYEVEYFIXBAIWFRTRRINET, BHIC. T EEE T
(Advanced range) | £TB#EE 1 (Standard range) 1D 2 DDIBAIR (Start) 1D{E
DEIZHIEVFIFEVWRTERIRESN, [ E#HEEFE (Advanced range) 1D IEA
(Start) |IOELVIELNEYFIXBABWFRTRRSINET,

AVARYIAVNEEE: UBTID/N—23 0 Tl AV AR AN YT Tad4 D5
FR.AVARIIWAVMEBRBE R KYRICEBMSNIZERLGE . BNOERNHDIGE.
BEE—FDTIL—N—/RILIZHBA VARG AV RDAVTFRAMNAZ2—I2H B
(A ARy ILAVREZETE (Change Instrument) ]IaY U RIEERTEE A TLE, O
NEDHIRIFBEMBRINTOETN, U TORITEFETIDELHYET,

AVARYILAVMIB T HERDODBMNREDSEE . HIFRSNIZERICEET D
T TRRLAIBREINET,
AVARYILAVMIB T HERDEMNBLIGE . FLLWEROHMEZEZ DR
PHERIEX. AVARIILARDF LB TICH-ERD TIEMD
ELTERRSINET,

ITRBIXINTIAURARY LAV REZERE (Change Instrument) 1 Z{EH352L1EFE
ETEEREADL XDV —RATHIETHFETT .

TEBFIN REOTOSIIMIBET HITEBF IO AV R AV ETSA4TSY
— (Library)] » T4 RbyILAUE (Instruments) 15 (7045 TiR&ET 52 &%, B
EDECATEE A, FOEH . TOCIHMNADTL—V—IZZY BTSN TLNAFT
EBXINMEI TAVRRS LAV (Instruments) 174 7RS DERIDY RMIIER T
NS BEE—FOTL—Y—/SRLIZH BV RS AV DAL TFRPAZ2—
Nl AVRRYIIL AV D EEZTRE (Edit Instrument Definition) 12#iR352¢3
TEEE A FEDY—RTIE, COHBERITHFETT

AVRRGIAVR T PR —ERTAT DIEE: AV RARYILAVRT 7R —DIRERL. TL—F
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—RAVAMIILAVNETODIIMIEMT SRV IEEDORERIFFLTEELE A,
FEDV)—ATIFH. CO=HDITT43—FBATHFETT

YIRIZKDEFDRE

Dorico TlE. SNETIYVRIZESERFDEYFOMEDHREFROONTULELA

TLtze SNIEMDYVIRIITICEVWT, FARELREELZSISREIIRRKDORERER

BN TWCENEBRATY . RRFDRATERHT S5-HICVUVILTRIVI T3

BRIZ. R TERP. REDGE I ZEHOEFEWDI/MI2EES)vILTLELY,
MSEWNSBICEYFERELTLESZ LB HYBFEHN T,

LML, CO&IGHRMEETVRATERITLHASEIE BICHREXNRER DIT-LE
FTTICTYVREFERAPTHIEE . LTCHEFTHAIZLIFERELTLVEL Iz, SBI,
RIAEE—NIIF—IT3—DNEAINIIET . E7/A—ILITA3—TEHD
EvFOTaL—a EYORATHRETEDLSITHYEL

CDESILGEBHIS, LEE—FOVIRICLBIHEBENET /O—ILMDAL DL
SEEETIRERIN, Y)vILTRSYI THIET, BIRLEEFOEYFHOTaL—
AVDRETEDLIICHYELE, ChIZIFiERFICEYFhTaL—avnDELLH
—ALMBRETELGVEWSHIRZMA TVET , =, RATICERABES 27U
T4—RN\wIERTL, BRENMRESNEIIELTVDESIERFLESHNKSIZHEST
WET,

RORZEDFRELGEFDREFITELRNEIITT HEELS Dorico &RED B
ZEEIHHEEF. BB EFTYIRICLLEROBEEZREICEMNCTIHILELE
LHATEFY,

EvFimsk: BEET—FT. EFEEEARICRSVI THET.EVFEERTESLIIC
BYELT=, BEFEIE—T B [Alt] ZHLI-FFICLFET (0FY. EFEZERL
T [Alt] ZLI-FF LTSRSV IHIET. MBEERTEEY ), FIvT 5L,
BBEDEEYFHNRESNET,

— &I, BEFELETIZRSYS 3 5E, [A+H[1)[I] T1 ATYT T O8ATH0D LR
[CEFNBIHAINET,

DALEDWMEZRE: KEARIZKSYT$5H5ET, EHENOMEICHEF-FIE
—TEFET . COGEEH. MOMEICEFEIE—T BICIE, [Alt] ZHLEFFICLE
T FIVITTHEVRALT )RR REN, EFEROVTIHMEDBRIZEYETS,
BESINLG/N\vt—V0HEBZTTFEADRAMIE, BIREE D FXLDHIIKFH,
HAGEEZTORBMEFETLNY . EREFDORRDEFTTLASILT. ED
BERALEESEEBBSNGNERLET,

CNIFBAE—FOMBANEZERTHEELTFTRSINGEBYDEBEZRE . &
[(FTHHEAE—RFEEDICLENS 1 DDPMEHDRABTERD/NEHDORRMEIZFS YT T
BIET. 2 DODINEHDEHFEANEZLONET

EDaTIT4—RR\v: ESv TR EEFOBRBEDMEZRY I —AMFELRT
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ShpestIc HEERITHREICIFBADORAMMN R TSN, T—ANFEDH
BICBRLET,

F
o
=~
I

WEEZX VY EILTHGERIF. YVRRA2—E WS RIIC [Esc] ZHLET

ROARELEME: COMBREEMNTIEE. REREDFHDOANLESE (Note

Input and Editing) IR—ZIZHLGEBIMESN IO REZFALTEROEYFLEUX
LRI BDIREEFZZF S (Enable note pitch and rhythmic position editing
using the mouse) 1A 7L avE&MIZLET,

F= BEREDF—HR—Fa—rhyr (Key Commands)IR—CDIFEFDA
71 (Note Input)JhTI)—IZH B I IRATERDEEEYIYEZ (Toggle Mouse
Note Editing) IV RICHRALDF—HR—Ra—rAvhZEEIYLTEH, v T
INZFERLTINAT U REZERUH I ET. COREE—FREYYEZONET,

BEBT AT LDOERK

Dorico 5 Version History

Dorico 5 Tl&. BIREEANSD T AT LIVERRMEEEN —FTSNFEL-, FRFIZERDT
AT LE DAV ARSILAVRT, SSIZEAVARIIILAVNDERG B EBIZIERK
TE5LSIHYELT,

LBIDN—2a3 Tl R OERICE-NEIEEEFRIRLTHLORY TEH—/1—1
REE—FONRILEFERALTTATLEERTHE. RAITERLIZAVRRYILAY
FD—FBRTOEIRGEIZ 1 DOTATLERSNDIZ(FTLIz, 2OIL—ILIZIE,
LODDFBETREFNANHYELIz. RT—PRBESIFEBHD ARy ILAY
FCRIBIZER CERCER. IR T AT LD TIIABREOERDLERIZLET
AT L (F—T4F2L—23 00w X7 —Ta4FaL—aVBE) L BRLEZTAR
TOEFRICEBFICERATEILGETT,, £z, BRAAFIZR LY ERDRE
RICEENDTWBBE ., Ry TA—N—HBETHERLETATLIETRTOERIC
EREnELT=,

SRIE. BIRULZBA VR AV MIBE LT AT LNMER SN D ESIZHYET,
DEFRETIE. BAURARIILAV LD BRGEDORNDERDEE (ThET NGB
al) ITHERSNFET A BETHNIEL. BRAVRMYILAVRDEICAE (FIRP—FAI
DILE) [CTATLEERT HLIILIEBETEET,

F- . BAVARYIIAVRTERINETAT LK., FEROBRTRICEGSINE
T o =EAIE EHDAV RIS ILAVNIEENDEET, SHORBUAENELRST:

23 Steinberg Media Technologies GmbH



@ steinberg

(FTTHL BROTaAL—Lav PRFORENRLLDLDERRLIZGEES. ThEh
DAVARY VAV STHERENST AT LIEBEYETaL—YavaEZo0NET,

—EDT AT LTIE, ELITHFHRLGEMEEZTHLDILHYET . LA TERBOMNEE
BRLT. ENTNOMEIZTILARCA BB ZRBFICERT 50 BEROHHNE
BAMBLERGLIERICETIMELGEIIHL. BHRDIT Y U RERIFITERT
BHILGENTEDLIITHYFELT -,

EERE 1 DFERIIERDOAVARIILAVCDER DB ICEF-NEBIREFTEER
FEERTAGE . EREEOERELGLIBAENENTFHH (Direction) INTHE
(Attribute) INDS RBEEN D K512 YFELTz, [ (Direction) | DB AR (LT
BT, hDBENRICE>TITEHEIN DD, Nhaturale [Tk > T VRSN DETH
BLET, COBIZIZEFH—PDIBTREENBITONET, —H. [EF (Attribute) |
DBEDRIE. TNDAREIN-EFOTaAL—avETEHEL. ROBFFTIEE
EMIZ YRS ET, COBIZIETYTRIOTIURI DIEREENEFOLNE
ER

[ (Direction) IO BEMRICTYE Y Sh-EBEBEZERLIZEE. B4
TaLb—avEED 1 DOEEBENMER SN BREEEDEREICHREL., ERHKEHL
3Ihhdh., SEEMNEYIRSNET,

—A.THE (Attribute) IOBEMRICTVEL T IN-ERREZZERLIZGE &
REN-EBFICENOBEBREENMEBSINET . CNhEFATLHE FEXERD
AV REEFEBICRRCHECEMTEZT I, [Ctr]] (Windows) F 7= (&
[Command] (macOS) #LAMNSI) I TERDEFEERL. [Shift]+[P] A
AL TEEBERYTA—/\—%FZE. Tupbow]EA LT [Return] B9 &, #iR
LE=&BRFICTYTRIDBESREENBMEINET,

TVvH R BRIDN—230 TR Uy R EERT SR, RRE LR TEDEAZE
BIRTHEL. BT OARRLTRTEFEBRHESEHILLTEELA . W
FTHOGEEBEREINDT Y URE 1 ROHAHTL =,

SRIE, BIREFEATTEDS LT ELDT VYU RAEBIERSNET, —EDEF
FZEIRL TSGR X, TR ETNOBY S -EFOMIZT )y U RAMERSh ., —
EOMBFRIRL VDG EE. ENTOREEMNLIEEIZ. ELELNDIFT DB
BEFEVBZET, TEBLITELDT VY URBERESNET , SRIEBLEAU R R
WAV DEHDERICELD>TETHAS=H. N—TDRAD4—TT7ILRITE
FRERTEE T,

TFILROFERE: TILRIFRREEFTHEMEEERIRL T, [Shift]+[0] TEMHERYT
A—N\—%FE. TarplEA AL T [Return] #3891+ T OB ICERKIZTIL
ROABEBEEFITONET,

EME LML EBREFDZTEFOMEICEMENMMEMSNDIIITHYELS =,

BEEEATEDIEFDOANLEE (Note Input and Editing) IR—UIZHEIRLE-FH
ZEIZ@RID ) JLEVERL (Create separate trills for each selected note) |47
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AVABMENFELz. BRTT HE BREFOEEFOME TR ILAMER SN E
T ATLAVEEMITTEHE, hDOYIERGEDRERIC1 DT D BEIREGED—
BAIOMENSIREY . BEREED—BRLDAETEROHNIILBMERSNET

RICEDT AT L RSy FEEMREL, MY E — MR, FS &/ EifEE, 3—F
B DRT/IERTDMEE., MIDI M)A —BEEVT I GBIRL-ERDAO RS
IWAUMZE N> THERTEE Y ERILI-BEEN TR DMEETaL—2avid,
FTRTDAV AR AVRTRLCIZEYET,

RNNAEBESINDTATLDGE: HRETIE. RAAEBRSINEITATLDEEIL.
BERORVDBFDMEIZL>TREINET , NITKY. fzE2IE 1 DD
TEHEMBEZIRLT, BIDERT [Shift] ZHLEASY)voLTI OV RIRE
THW, BHOERICHI > TEFLARFTEERLTH L, [Shift]+[D] TRy T4+ —
N—ZRNTATEUZEMT 5. EVSEBRGRIET. ATEUDNEERITER SN,
BEROERD—BAICHIBFRAIFEBEEIZRYET,

BERDTDMEICEHRNDHINEIMNChHHIHLT . EREBEDBIIBAIE ZFEIN
LEZATLEERTIDENDHSIHEIL. BEREDEHDOAHNLEE (Note
Input and Editing) IX—> DI §R&E (Editing) 10> avH A BIREN TN EEY)
DEFDRIBIZT AT LZEIERL (Create items at position of first selected note) |
ZRRLET,

7' —ILRI(E[Behind Bars]OH T, ERESOEE T EFOEATIILL, TENIK

INTIRDMBE CTERTHILEHRLTVET, TDEH . ERSKTLEIRADET

FOREICEERFEBZ/ER (Create clefs at position of first selected note) |74~

avEEMICAEL. 2RELTEIRIDOEROERICTATLEZERT 58 TH.
EMRSFERGEEORBMUEITERT EINEINERFRIEETESLIITHE-TLY

E3 I

Dorico 5 Version History 25 Steinberg Media Technologies GmbH



@ steinberg

WER

EREFRC 5

EvFEBBOEBIES0ERENE: TI4ILED 24-EDO FAESRTLOWLWT D
FOILGHEFAM L AT LEERT 5154 . MIDI F—R—KFi5ETHREEL 12-EDO E
yFEAILTH L, [Shift]+[AIt]+[1)[|] CEVFEETHET, BHOWMH B DEE
RS (CRESELDON—RITT,

LAL. Dorico MURIND/N—30 Tl RIZE DGR SN BRSNS FAEIL
[ZKWMGEP. BT LETRTOERBELRRESNDIDTTIERWNGEELRHYELT-,

SERIX. EVFELAMICEELTELGAEYFISRICEELLGEFIHLIIVE
BRI SN RIREN, HICEYFETARICEETSEHAEIHRL O v—T 116k
FEL S NBRSNSIIIBYFES  EVvFE—EARICEELEITSE5. EVFD
EEDOLA L —ETHYRITES

A—TaAEEHL
TOCORDAEMILICETIESLS: BENEM ST EWTO OO A —T 47

(Ff=IE MIDI) #EEHZ5LT 5L, TADIIMNDBEZEIMELTOVLEETRE
BHHEVSIEENRRINDSIIITGYELS,

INRES

RAFORBERMED/NIES: MNIBESEIT R TOMEDORIBMEICRRT HERTE
T, HEORMBEEICERRFALHY . M OTRARFE JUHESh =/ E—ND
SN TFIZ/IMIES DEFHZERT (Show ranges of bar numbers under multi-bar
rests and consolidated bar repeats) IOA TS avNEHTHAIEE . AKX ET
X Z DR DRBMEI/NHBES IR TINEL A,

LHOL. RAFOTIZRTTH8HEICMA T, @FESYHEEDORBREEIZ 1 DD/
HBESEZRTTDIONFELVNGEILHYVET . COBZBEIKX LATIMETToavm
[INiZEE (Bar Numbers) IR—U T, #if-iiA T a  THHEZR T 5RAFDE
MMELRCHEICHIIHE . BED/NHESERT (Show normal bar number
if coincident with start of multi-bar rest showing range) IZ&B%IZLE 3,

KEARDES|: INIESZ/NERICERMATRES D LEEETEDRIIAHYFEL,

NBEBSDERZERT MIBFSOEETRELI/NHES(E, Dvo TIMIFEIEH
ARG LF—HR—F2a—bhybD o7V ERATESIFATLERTIERT
(Hide/Show Item)|a< KT, JERRICTESKRIICHEYFELT =,

KIER (TS5 vk) EhET (TL1R)

NAFVREIFEIL: LA 7O T o3> Ol KigilES#ETl (Brackets and Braces) X
—DICTBYEI/\AA T L—r—DEIFETR (Sub-brackets for adjacent violin
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players) 14723V NFifzITEMEN ., XA A U2 1 EnNAF U2 2 DEI2aVTL
— XV —DESZHEET BN\ AF)TL—v—., BRI OBIEIREERTSL5EE
TEDLIITHYFEL= CNIFFICTA T EERT HHE . EDERNEDTL—
Y—IZBTHEDD. T<CIThDBELSICTHLETRICIIEET, LTD 3 DDFEIR
EOHYET,
M D (Single)ll. MR ETENFNICRRINDERDEIZEREL /N1
AU 1 ERAAFYY 2 M1 DDEIENTHRESNET,
53 Bf (Separate)|l&. #iEE ETENENIC 1 DDERLHAKRTINGEGES
TH, BIZNAAYD 1 ERX1F )Y 2 IZARDBRIEIARTINET,
FERDERIZH B (Separate for multiple staves)l(d. IR ETEhEFh
[ZEERA 1 DT DLARTSNGVGE X AT Y 1 EnN(F)2 2 B8 1
DOEFENTHEINET N B LTI NDIZERDERNRTIND
BEIX. FDAVRARYIILAV LD HEFEIMNRRINET,

BHEIEE 1 B —B: L4794+ ToarnlI KiEil & iEIl (Brackets and

Braces) IN—J [ FzICEBMEINTREIEMNEE 1 EMN—HTSH1H5E (When
sub-bracket matches primary bracket) 147723 (&, 5 2 {FIIOEEMNE 1 5
MOEHEE—HT SH15E. BIIENZRET AN EINTIEETEET,

= e VN
J0—DRENEICRTSNS, JO—THEASNSGI—FF (T 5L a—FiES&a—

a—F

Dorico 5 Version History

=
=

:l_

RFEAT IS LDEEICRETILELT—ENREN—RELT, [PA—TEATILS
O—REAT7TS5LE7O0—DRKEIEIZRT (Show chord diagrams used at
start of flow) IV E#LE TA—DRYDHEEDRIIRRINSGI—RFA(T IS
LDYAZXHELSCAESN ., a—REAT IS LE T THIEBE SNz a—REES DO
KERBEN, FNONTRTHEICEB IL—LDBERNICRESLSIHYELE,

FERBDERE: FEAT3>DIa—FEEH (Chord Symbols) IN— DI E
(Position)1o>av(z, 1M fTREDOI—FEBIHT2ERITREDI—FEED
EJIGIE (Alignment of multi-line chord symbols relative to single-line chord
symbols) 14T arh#FHtfzICBMEShELI,

Alignment of multi-line chord symbols relative to single-line chord symbols:

COATavE 1 DOBBEDEROHIAYI—F (F=FKR)3—F) 0a—rESE
Z3THVNI—FESHHAEE. 1 ITREIDI—FEESEERITREIDI—FEE
FOLE. PR TOEZIZEINSELINRELET,
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HRI—REBEDKEAMDES: HEA T3> DIO—FEES (Chord Symbols) JX—
COIGLE (Position) 27 avIz, AL O—REEBICH T H5BHALI-a—FEED
IKEH R DESF (Horizontal alignment of transposed chord symbol relative to
main chord symbol) 147 a3 N gf=IZEBMmEShELT=,

Horizontal alignment of transposed chord symbol relative to main chord symbol:

BMENTOCIVRTE., TOA—FEEICHLLEDI—REENTETESY E£H
AShFETA HRTOD IR, EOI—FREESNFRRBZINDESIZHYFET,

IW—FDEILRBEERZVIRDA AL — a3V DEE: FEF T arnla—FiRs
(Chord Symbols) IXR—V 2, O—REEDIIL—FDELEEEDLE DM R LEE.
BLURAYIIROA I EL—2a0 DKTEMEICETHUTOHFH LA T avhiE
mEnFEL,

I (Position)ltz2 3> DIFEERIE (Vertical Position)IZ#f=IZiE N
SNf-TE#MEEE (Advanced Options)l1to a3Vl A—REEDIL—LD
—HMELTRTRENDELEEDEENELTHETELR—RFM/UIZHS
IL—FrDELEEDEBELF 7Y (Vertical offset for baseline root
accidentals) |DfEA#FT=[TEMENFELT=,

FRCEI2aAVIT TREYIROF NI —a 2B ENDOEEL It
vy (Vertical offset for parentheses around stacked alterations) |47
IVUNFITEBMINELz, CRIERZYTIKDA ILIL—ar DESLE
FEOCRENOEEMEZFIHILET,

[AILAL— 3y (Alterations) 1 293> DINIL—RIHTBRAVIRKDA
ILEAL—3 0 DEIE (Position of stacked alterations relative to root)|
(&, MEIRAYIINFA AL —2a0FD—REEBDR—X T VIZHIZ D H
(TIL—KMZTHiz (Align bottom with root)]). L—F XL THRHZ TS
M (ML—KZthRi§iz (Center align on root)]) ZRELET,
ECLTAILEL—23Y (Alterations) | £ a> DI RBYIRKRDFILEL—
arNIKFEH R DS (Horizontal alignment of stacked alterations) | (3.
RAAYIRDA N EAL—2a0 DHEEOMERZRZE. [ERIZ (Left aligned))
(29 B thkfi % (Center aligned) (2T AMBIRTEET,

FlOgx: BEAT3>DIa—FiE S (Chord Symbols) IR— D TFR
(Parentheses) | /3 I [ER LOBRETIIa—FESOEIITEHLE TEN
NDESLFET S (Scale parentheses to height of chord symbol with linear
arrangement) |4 73 A FfzITBMSNELT =,
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- FRESERLICEESATOZBE T, EAEFLI—FORORBOBS
ERMLT, FUOBSERET FELTEET RV IROA VAL —La £
ALELI—FRETA— OB ah e EIEEAT 2 HAE. COFTa
VERPICLET COBREMIMELOTT A, TEO L2, 3 2HBI—FiES
D35 1 DHOIA—FEEOHHENTNET.

(E/GE) (E) (Em7%)) (E/G#) (E) (Em73Y)

L) HEY

6/9 MA—REESDNE: FEF T3> DIa—KEES (Chord Symbols) IR—C D EFR
5 avIZHB6/9 DS E] (Appearance of 6/9 chords) 1A 7S 32, [6th & 9th
USNICEMDALEL—2arRNH5a—FIC 6/19 D4 E%EFER (Use 6/9
appearance for chords with a sixth and ninth and additional alterations) 7=
IRV I AN FIZEBMEINELIZ, ChEBFHICL T, 6/9 Oa—FEEF(EM6(add9)]
TIE7E<T6/9 1D TRRENDLIITRET HE. 6/9 A—RITEMDF ILEL— 3y
NHBHI—FIE, &R IXTCB(add 9, #11)1TIFAEL TCO/O#I1) 1D LIITRIRENFE
ED

A—REBMEE: O—RESERTLEVAV R ILAVIDERICO—FEE S MHEEEIE
—TURR=XILIGE ERELEF L (T) OERICEBZERLTI—FES
MEEEIE—F - EBELIZBE. TOTL—V—DI—FiEBDRTF/ERTDHE
A BEISEYCEFHFSNDRIITRYELT=,

BETVE—T8

BEEE B EAVA—T % IERR: Dorico TlE. HEDLATIrDBRIHESI BRI EF
FERTRICTIFENBICRESNTEEL 2, INIF LA, BEFCIMBOR
RERDT-HICTHEEERRIELA, BLOTL—Y—ENELAH-TER
[ZET . OLAMVRIIIAV DR ELIFERLGLIEHEE~DERE(TE (T
EBZD. TD&IGZENHLH-OTT , EELDOHEELLTIEIRILTHA AT V53—
THRIZOWNTH, AHRROZENBEINTLET,

ZD=6H . TOINTAIRILDTEEFES (Clefs)1ETAU4—T# (Octave Lines)]
DY I —TIZTERTF (Hide)1TO/STohBMEN, BEDLATINTEERES
AV A—TREFERTRICTEDLSITHEYELS =,

Fo. ARRLF—HR—Fa— Ay EEIYETEN DY TINEERZBLT. [PALT
LERRIFERT (Hide/Show Item) ]IV U REFEATEHETEH, BB EA I 5—
T DOIIERTR (Hide) 1 TAN\TAZPYEZLNET,

=114

AVTILIYT
AVTUVVTBEDER: BRIV TV T HEOERIOAARUNDT AT LE
BIRL-IREETI%E (Engrave)] » MaAvFUo U5 AHEDZERE (Condensing
Change) |Z:E&IRT 5L, ERGED—BRIZHEITATLOEETEHRFEDIVTY
DU HEDEENBRAINTLSENAFARNL ., BRSATWSIGEEFFHLLIY
TV HEDEREERET . FDAVTUL U AEDERICHR T HREHIE

\
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maEnadEIHEYEL,
M9 S

SIVTORDHA XM ATEVORBHREF IR THREICRTIN, BEHDL
BEZ LTS, FEEEFTEEE T IFARBMLRBEZRI=TOTOARITDL
T.HRBRIOCOMTRT IAN MDA AR KRELLGYFE L=, T B ELF T3y
DI5458EEH (Dynamics)IN— DI EXFERITRSEEES (Gradual Dynamics)1t2Y
avDIEMERTE (Advanced Options) 172 avVIZETZIUTDADRREE
(Scale factor for niente circle) |47 ar A FH=ITEMESN, SSTFAHIZEHE
RN TELLIITLELTLET,

LI ZIVTOREATEVIHFFTICOLAINRICEELTERET S e iFOH
fRttEBYETH. HILLA TV IAFEL ORIGEHEZTIOTDREDRIFE (Gap
between end of hairpin and niente circle)JIZ&Y . ChHBHRICARTEZT, )
HRETE,. FRIODIINTCEATELDIHEZIVTOADMEIZ4 5D 1 AR—
ADMEEMNTESLIIZHYFELT =,

—IVTONE: FEF T3 DIATEEES (Dynamics) IR—U DI ERFEGETERE S
(Gradual Dynamics) |73 ICIZTTMDREA)L 'n' (Style for niente 'n") 174
ToavhFHzICEMEN . ATEVORIBREF IR THRED=T TRED ]
[S.AFETL—rRMADELLEHERAT AMNBIRTESHLIITHYELT,

ATEVOTFRS: BELF T OI#ETEES (Dynamics)1X— Ol BFEIIETE RS
(Gradual Dynamics) 1tV 3 IZ IN\FEVHRATBOBHFTFACDEER
i& (Vertical position of modifier text inside center of hairpin) 177 a2 A% 1=
(SIS, ATE DO R(IZTpocolFE =X moltol DT F R ERTT BIHE. TD
TIHIVEDEEF TV IEE TEALIITHRYELT,

ERPERIRE5 58S D ALER: [Shift]+[D] DRy TAH—/\—Tlcresc... 1 F/=(Edim...|EA T
T5& TRBEARBIEBDRAEAMIL (Gradual style) IO TO/ T4, TFAM—X
DEEPEHIRTE R B ICERRER T T HLSBBMITHRESNDLSICHYEL,

IHRTLyiaveyvS

RAVFEEDTALA: FRIIEAL (SARBAL) AENH YR, SR E Y ER

[SERTHEDLENTHCZRDENHYET . TD=H. TDOXIGY I URERE
RY5ERITOVNTIE, 7RV DEBEZEIT-OICHBMEZRET DN — AR
T,
NEBEFMICEERT 501 T4 n 2UF (Delay n milliseconds) (& ]
HIEZRETHIET. TIVRT LY av Iy TDRAYFTEICIURBERDT LA
FHRETEASIILYEL, ERERELYLBERESEIERIETITROHIE
. BRBIEIGERIETSIROBEERELET .

BEL-ERICENETNELRETALMEZR DR DRV FERLELESTHBEN
KENEYLETONTVSEE . F—N\—SV TN RETIEENHYET,
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F—IT45—
NOAVTA—IT49— BRI T48—~vF—IZ BEIRGED— BRI HEHEF OO

UTA—DEERTT DAEVRYIANEBMESNFEL z, CCORTEEZEET HE.
BRADITRTOEFOROALT—HEHFNFT,

EBIT, IFAE—HDIIRRA L E—DEE L BICHET BRAL T — BN E
RRSNHESIBYELL,

BBITA%— EROITA3—~VF—[2 BRLI-ARA UM ERBEHERERAMNIY
M —ERFRA NS EMEETEHREUNEMESNEL, COFETHRET
EDDFREY—ILDFAY—IILTHERLIE=FWERIZE T 5 RA U MZIF T, X3
T DEBRETITHE T HED BT, ChoDHRIV EEMITLGYET,

MIDI CC TF 14— IRIEFREDEFD AN LIEE (Note Input and Editing) |X—2 T
[Ei#EIE—T . F—IT14—H 5D MIDI CC, EYFARUR, BBRESTEEDH
% (Include MIDI CC, pitch bend and dynamics from Key Editor when copying
music)IZB#IZT H&. MIDI CC T—2ER—RMF HEE, R—X &5 MIDI CC
T—EANTRT 1 DOFRHEAEBEEHIZT— SN B0 TEGL, BEEOHEE A H T
SNET,

W—5— F—IT43—DI—F—FEBEE-FOIYIBMETHEITILI)VITHE,

ZTOMENSBEMNRIEEINSLIITHEYFELT,
LL7ok

N—rERZEIE—T % EOE—FHLTEH, ODv o TINETEzIEF—R—F3—rAvk
Tl—MEX%E2E—7 % (Propagate Part Formatting) Ia< U RZIFEUH T EA
TEAHLIITHYELT,

4T3 —RR—Tr—

YIR—bFTB54T3) =7/ ILDIEM: SAT3)—IF*—T¥—I&, TOTS LD DER
AhLEEFHINTz Dorico 47 3)—774IL (;zEAIXTITEBFYLERSE (Edit
Percussion Kit) |#47AS MH IR R—,SNT3TESRZ TN ZELMIETES L
2UTEYFLT =,

BARZBEOIER: HEA T3> DOIIE (Lyrics) IN—C DIIER#E (Extender Lines) ]t
9oV TERHOIDLYIZCBFRED/N1I7%EM (Use Japanese hyphens
instead of extender line) |47 avhBMENEL Iz, CNIEFHHRTODTIRTE
BHEIOCIINCE, IR ETEAIICHSTOWET, COAF T avza/RICTS
L BHOBRIZELP>THRONLSEE ©. 24 TOELNT 1 FITH LT, FrEAD
ERFERTTHHODOYIC, RHBEMEICBREDNAITVNRTINET,

PEADERBOMLE: WADERBEDE IR, ERBOBRIHEDHNEICHAIFEDAIHE
BEMICRi AN A EIIZHYFELT=,

HEADINAT: MERETIE. TWEHRADNATUIE. RBEDOTFADSADTIAHILED N
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SYSTRAMNEFERLTHBEINET . (VDI CEIZHIDFEDEEH. (1=
EZIETIRSHG 5T R B L)L (Paragraph style) 170/ T4 EEELT) BD/SHS
TR/ NEFERALTNBIGEE . NAIVIZERIL/INST S TR DA LEELTERA
ENBES5I2EYFELT=,

TMEADTA U EmEIDIERITAR—R: TMEFADS A %#mEE (Edit Line of Lyrics)|5
A7 AT, TEAPDIERITAR=RF. OIS BFEATRRTINET . I
ADREDICERITAR—RZENMEL-EIBB I LOILENHDES.
[Shift]+[Alt]+[Space] ZANT HEFERRMNEBMEN, FATOTEHEE T HEFR
TRAR—=RIZEEMAGNDKIITHYFELI,

BEIAVE

HFLWE R T+ T731)—: SMUFL (Standard Music Font Layout, 123 & 4> kA
Tob) DERKIZEY, Dorico DHHARE T HE T4+ THS Bravura +° Petaluma &
BL SIL Open Font License M{HEN) —RENT=FE I+ IT7I)—HUKDOHH
UET,LOL. CN6D 7+ DAV AR—=ILIE—RBIIZEN T, FHTIVAM—IL
FTEMNMDT TV r—2a30 AV A= VT HIENDBERBELHYET . £ T,
Dorico 5 [ZIZET=ICULT D 8 DDEEIA VL IT7I—MNAU R —ILENFELT=,

Finale Ash: Bi&#& Ashley Wells DFEZ(Z&5F 4% AshMusic 74+ &
HERMICEREL-FEZRTI+ITT,

Finale Broadway: fiLA\RUEDA IRV EAA—DLTHEONI-FEZTRD
AURTT,

Finale Jazz: ;5> ~RwA2—® Rich Sigler A3, Clinton Roemer D #HR 5%
DAVIRUIZEDFEEDEEEEL T FEERTIAMTY,

Finale Maestro: Bravura ERIBRDFRMZEZFEAL. EARMICKSEHAZ-5E
AALILD I+ TT,

Golden Age: Don Rice D F&Z(Z&% Golden Age 74 IR MIICEI
LI=FEZRIAVNTT, T+ bDI A&, Finale Broadway D #L 41 E7
& Finale Jazz DIEBEIZRKWWAEOFEIZHIZVET,

Leipzig: Etienne Darbellay & Jean-Frangois Marti ASZESE{ERLY T b
Wolfgang D 1=6IZBAFL . IR Verovio 7OP VM THREILEHNTINS
FERXIILD T+ RTT, Bravura 4> Finale Maestro kY3 512X kA—
JOAVISAMDELBYET,

Leland: MuseScore M1=1Z Simon Smith & Martin Keary A\BiFL1-%E
RAAINDIA2ETY, 8 Leland Smith [CkBH#EHDEEERYIH
[SCOREIDNERZEELI=TH A1 TY,

Sebastian: Florian Kretlow & Ben Byram-Wigfield DEFIZkHFER 2
LD I+ TY, Bravura EE4E. Sebastian D &AL EREITH TR
YEY,

EBIT, SNBDFETF VDK ONE, THFRNTA VR T7I)—EABHET
ERYAHIET. EERMICRMOEN-ROT7 ONEERELET .
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J0oxHbTIS4751)— (Library)l B T'EZE T4k (Music Fonts) 1IN 5:ERT 5
LT HDBEIAVINENWDOTHERATEEY,

TEXERARDIAUNTT7I)—: TAVRBEEDART—RIT7AIVIZHERET X AN IA R T 7S
J—DEESNTUWVEWGEE . TIAHIND IV RENRSTSTREAIVIERT ST
#>bHY Academico 121 yben B EMEHEYELT=,

MusicXML OEZHL

HEEDZEK: Dorico MoEEHEINS MusicXML 77 J)LIZ #HEERTIY B LUV ITL—L4
XY (MusicXML BB TIIR—VRYY) AMEESNE LS ET, EEHE
NBELATORDMEBEOEXN T O—KRShBE3IZHYEL,

R—SHPA X HERHAX, £A: MusicXML ZZZHTE. LTI T30 DIR—
DETE (Page Setup)IR—U THRELER—UH A XEERY A ANI a—KREh
BEINTEYFELz, BERNGR—CKRBLBEETEEF TN ESHINLIREET 1 &
‘JI~0)<7%75£0)’C RAER—CTCREAZRBPEMEERBEFERTILATIID

58, EEHIVA—RIEIThbhEE A,

BRIAVNETXARI AR MusicXML ZZ2EHI R, TOC I TCHEALTONSER
TAUREA VT X RN IA DB FINEEHINBEES(THYFELT=,

774 )Li5EF: Dorico M EEHINF-IEEHE MusicXML F7AIILIZIELWNT 7 A ILYLEE
FTH5 .musicxml HFE, MusicXML 4.0 77 ILTHAZEMNEDHBESIZHEYE
L/T:o

FFEE: Dorico NEfFEE YN X LZEMHFEE (X and Diamond Noteheads)]. [X &V
EWMDFEE (K) (Large X and Diamond Noteheads) 1. [fL{+E#F5E (X) (Large
Circled Noteheads) 1A%, MusicXML IZIELLEEHEN B LS12HEYELT-,

MusicXML DFAAH

ERESEAKRIESEES: MusicXML 7ML I7TILY—4E, TLAES. PREIALEEN
FAHAENDESIZHYELT=,

Dorico Tl&., Zz/LY—2LRKIEEE B, — ARG A EZERBL T, SHER
DI RTDAVARLYIILAVMNZEET B O—NILETATLELTHROAET A,
MusicXML TIXINIZEEINTOER A, =&AL MusicXML 774 ILTIX, 7L
Y—3% 1 DDERDHAHIZTO—FTHIEETEFT A, Dorico Tl ZNDTT/LT
—REFTARTDAVRARYIAVEDEZ AT HIMEICENET , TDT=8 . MusicXML
MWD EIET AT LEFHAIADER. Dorico [£ MusicXML 77/ )ILAD I /LI —74
PHEKRLESESHL. FIL—TLTEYETA—NILTA T LOAERSINS
FOITLFET , DFY Tz —2EHREARLE RS A MusicXML 7 )LICT a—kE
NIREFHSTKRILMEBICEN D EIFRIESNFELT AL EEMIZITEIZEICHE
SRR/ ONDIELT T,

SHICHERLEBETLAREBEDOEEIZDOVNT, 7I) r—avIitk>THREIKL
ESDHMENRLDEVSEMEEEAHYET , Dorico TIX, EQT TV r—ay
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A MusicXML 774 )LEEEHLIMNIEIKEL—)RTavI%FAL. TESZIT
BEREN-EBYDRENEONIBEZEOHIIELTVET,

ZfE: MusicXML TIEZ U O—F CELEMBTHARILHRESN TULVET A, Dorico [T
A= TALABEE—2 A 9FBRT R TOEMBTESZAADHDESIZHY
FL1-,

N—EFEZYR: MusicXML 7ML BRAN—EZIREANTIN—FEZI)RZHGHAD S
FITBYFELT =,

BERE SEERBOSA—NA—TUIAMNTDIERES . REBZDEROIAVTEBP®
AFYTEFH—rDIBREEHE ., FYBILLVESREEE MusicXML 774 )Lhvb 5k
HIADHBESZIEYELT =,

E51Z MusicXML (&, lNother-technical IO EFRZEFAL T, LB T —T+— LD
ERBURETXIRANERIET)I7ELTIUO—RTEET A, Dorico [FHREERLT
NoZBEREERELTHERARAEIELFT . INoZHmARAADLKERNTEHZE(E.
IRFE R E DOIMusicXML @ 5% & A & (MusicXML Import) | R — 2 T T other-
technical JEEBZFHAAL (Import other-technical playing techniques) 1%
|MLET,

RSN ERSRNILTDAVARYILAVIDBRADFNAKRBICHESNELT =,
MusicXML 774 ILDEERSANILIE, f=&Z (£ Clarinet in BblET Y a—REnTLVE
9, Dorico [FZD/N—rEIS 2 vDEDELTELLRELFET A, MusicXML 77
AILIMNSIN—FBEEREICIRYRAH ., EERSNILIZLAT O ToavN@ERshS L.
[Clarinet in Bb in Bb D KIZERARRALZBIMIZHE>TLEVET .

Dorico [& MusicXML 7 ILD/IN—FRZEBEFTLTA U ALYIL AV NG EFBERAZE R
(24 L. Dorico M BEIEERSARILA MusicXML 77/ L THRESNI=-SEETED
BBY—BTELIICLATIOMATLav0BEFTLaVERHET HENS, KUY
77O0—FEELTULET,

KRV LAV OERORE: EEBOEH, FITET /HEDKBRAV R
LAV R RBETHAAGE. Dorico ANRIRT 2EHMOME (FHOHEN LAE
MTFEEMEEL—URT0 I THER) 55, LEIOA—Da0 Tl BSTEREAT
THRIEALEFROME LR T LE—HUEDZENBYEL, TOT8H. #hD
BECEHDBMETEIBI, PR LBIEITOLAZBENBYELL,
STREROREERH DT TA—FHRRIN, AEREoFYLENEDOBE,

LTRELTRZEOFENZREBEIZENSZDTIELEL, LERAEOFENT IAHILNILRE
EHIT ERICE—DERHIEBICHENLEREIZHSESIZTEREINET,

BEROTIL—TE

HIREALDEFDT IV—Tb: LA T ar DIFEFDS IL—F 1k (Note Grouping) )
R—=IDIEINF D & B TS (Time Signatures With Half-Bars) 1 73 3>(2,
[HYRAEEAA LDHEFREBICAEV A LLERRDBTHFOST IL—FLEMER (Use
common time note grouping for cut common time signatures) 147 3> h#h

onji

l_lll-|;
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f=IZEBMENELIz, ChEEMIZTHE. 22 BEXUAYRIEVEALDER. BT
IW—T KEFDTIL—T1EIZ 4/4 F=IFTEEZALDIL—ILMEREINBLSIZEY
EX I

MfAFEES (Time Signatures) 1V IL—F I =HTONTATAEVEZALDEHFD
S IL—FitZER (Use common time note grouping)lhyEiEh, HEIZIGLT,
AVRIEV A LDBEFPARFEITU A LEELHETY IL—TILT Bz DFLL
A TavE BaOBFREICRIRMISERTESESICHYELE,

BHRDODAN

FITNEVTTHREFDEEAN: 4 PEFGS [6] £ 1 H. TR 4 DEFGS [6] % 2

ElE ANTEEROREDFX—% 2 MEHKTHYTIHET, RIZANTHERE
HRICTDIIFBETEDLIIHEYELL=,

hiF EFAANENGEE (DFEYF VYL IIARTEINTNSEE) & BRLEE
FDTAL—2avcmETHEESDELLTHRATEEI A . EvFETaL—3
CDRINIEET DANDENGEZEERTETEA,

7O0—0# T AEI/METEEM: RIEFREDNF—HR—Fa—rhvk (Key Commands) ]

R—SDIFEHFDAA (Note Input)jHhTI)—IZ. [JO0—D T LIEI</MEZ BN
(Add Bar at End of Flow) | a< RO FiTzIZBMESh ., 7O0—D# T EI/METZEE
MTBHRELDSI—rhyrEEYETEHIENTESLSICHEYFELZ, 2OaATUR
(&, v TINEIDLER) T —TEET,

INERZHIRR: THRER (Edit)] »T/NETZHIBR (Delete Bars) 12U RI&, /NEIDHIBR A iE A

ROMYPILLGHIEERERILTVET  BIRRT /M EilL BIRSN =T AT LDSE
—BHZHEILDE—BRAICHAHILDDULETHESNET,

BE—FEDOI EO: ALEEHDERZFMTOUCLEE ZRPIGERSNEREZITTEL

BEDEEEZTHIIRTOERT. MFOE—FEON EONREENSLIIC
ﬁt)ibf:o

BERDRAR—IUT

Dorico 5 Version History

BEHDIIDNERI: FEE—FRTEFDAR— VT EIRETHEE. TLEFADS O—

NILAR—=L U5 DFIZIZEAVNYRILNRRINET BIRT & FREFAD
TEAWNANVRIVIZIZFDERERDZFDIT O—NILAR=20 5 DHIZBRTRT7ATLD
BFEDHIIET S, 1 DELIFEHDOIVDVN\VRILARRTEINET,

Fa—\LHE, AENAZERBNNVRILLE RGO, —BTHMNET L
ML, FEDINREBNH =M EIMNERT HITIE. MALNURILERIRL-EE
LOVRWANAVRILARTENGWNH. RIETHIEANNURILERIRT IDLELH
LJ-aEL/T:o

Dorico 5 Tl&. ABMAA=FEDFIZIEEIZHLNAVRILBNRTRERESNSESIC
EEINTVET, ChITEY FEHDFIDAR— U T RBENTRONEELE
THLROFPI<HYEL,
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3

TI7AICDESHEDEM: BEE—FOEHZT/AAR/LDON/OYHLH K (Baroque
and Classical) | z72avIZ KYUSHKRETIHILEDEHE A BMENELT-,

R—=TFUTL—F

R—=CTFUTL—hDZEHAH: UHTIDN—230TlE SATS—T7AILDSR—TF
I EBRAFADE. TXRNIL—LERZTHERASNTWIHRILINSTFTR
AL, FEARAAFEDTAOSTIMNIBEIZRILR M ILAEENTLSICEHEH ST,
BHELTLESIENKLBYELE=,

ST AR—CTFUTL—FDHEHRAHEIZIE. INSTFTTRABAILOXFERELILN
SYBBLTHEAREFENDLSICHSDTVET A2 IILIFA—F —FEET. hDOFHEH
ABFEDOTADIINMIFLEFELEWMGEDHHRHRAENDESICHYFEL,

R=CFUTL—hDEZHL: R—STFUTL—IBRTHFRRNIL—LDEEIZHRILX
FREAAIIWE 1 DULEFEARALTWSIGE . EEHLEF4T3)—I74LICCThLDR
BAILREENEESITHYELT-,

REILER

RENWREI—D BIRL-BHORTIWAREI—DFT B, I—V SN =B RTJLEE D
B BICHTDEMEIZ, UTAINMERINDLSITHEYELT -,

B&

RETLSOHEE: RETLSICHESIB. HEDEFORBIESHEDTATLIZDONT,
EDBEBEIDABETDHENIETRIBEGIZGENHYFET . ChERRT H120.
TANRTARRILDOI— (Common) 1 FIIL—TI12HEHTBLEEME (Suppress
playback) | 7O/ AT 4 M EEREH  BIRLE=T A TLDBEDQIMNFIZER (Always)]
(BEIDEYIRLE) M IFEDIRYRLE (On Passes)] (1 BE=(XEHDIEESN
T=#2YRLEF) A IBETEDLSITYFELL -,

METEDHEYRLEF (On Passes)|Z:&IRLI-I5E . HIRETIX. PATLITTART
DEELEICEESNET, FOBBEICEELGVLAEIEETRIZIE. TBEEN
#l (Suppress playback) IO T < TFIZHHMHIFIT S8 YRLE (Suppress on
passes) | TANTAZEMILT. FATLEBELGOEREBRFIEELET,

AEOBEBEEFF X111 EHDERLEFIE2], EWVS-BEETY , BELGLEIBH
PNERHAHBEEEHVIRYYDIALTIEEL., BRI NATUTHEELTF Y fz&X
(. M1,35-71DFINHEYETS,

TURTATLOBEZNGIT L. PHEHEENHIIGENH LD TELTK
ZEW, BRMIZE, REEMT U REREDRIICHAENRD T REEZ—ERDRIB[E
DAHMFLI=HE | RENTORERIL, BIFEOTUREEDIFIALENA =MD K
SITEESN, DFEYIMHIESNET OTURNSTUREREZRIBLET

BAZIH: REZREDIF—HR—FIa—rhyk (Key Commands) | R—> DIRE
(Edit) ) hTT)—ICTEEOMHEHZLIYEZ (Toggle Suppress Playback) Ok
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NEMEN, HREZLF—R—Fa—rhyb PO TN EERLT, BIRLEZ7 A
T LOTEEZIEH (Suppress playback) 1 7O/N\T4EPYEZ LNDESITHYZEL
T=

RE IR REIJVENE—NNEHIROVE —MEIZFECHEE. ZELEYERBET S
CEERBLTELKBAESNS KB YFELS,

FUED: FLERIZH W T EYIDT —T4F2L—230 (FOEUMNIE) L. TRTHE
TRYBSINZDTIEEL FLEOD 1 BODHZNENBENDESITHYELE, &
2. T2L—23vD7—T14FaLb—>ay (RAVA—rEE) I2TDOVWTIE, FLEBRD
FTRTOEISHEASINDLSIZHYFELL -,

ElAEESNIFLEDX, FLEORMNO—VERTIHEROEELOTL—
2av TR PLEADBREDERSNST AL —avITBL-#EG/—bRE
DEHTEESNDIIIEYFELT =,

/—rREDEH: THRTL YL avI v T TEDRAYFEFERTHMNRET B, X7
THEASNTLSEFEDERREMOMAELEN. 1 DOR—XRAYF, FER
—RARAYFE 1 DULEDTRAVRMyF A EHEICEEZEIVEL T SNiELS
B. INITERASNBAIREVATLNARAESINTVWET, TVRTLyiavIvyTMR
AVFN/—rREDEHETELTVESEE . BERINTLWSIBENRDIBI-EX
(1 DLEFICLOA—BET . LAL/—FREDEHIT—HTHLIGRMvTF I, BE
IZRBITEIRSN D KSR YFELL,

BIEDRIDA—T: BEA T3> DIEFEEEE (Dynamics) IXN—C DR DH—T
(Dynamic Curve) 7> av (2, BB O&/NMLRJL (Minimum dynamic level) &
M&FFDHmAL )L (Maximum dynamic level) ID 2 DA T arA#FH-IZEMSH
FLI ZDRDELSY BB DEESDH—T DHIFHDERBLANILERETHET,
EARNGARBOHHELTEETEET .

MHRETIEENENT-61ET6IIZERTES AL, preree & II55F [TRELET . HFEZEAE
BT BFR, prr & 11f DERZHEADRBESEER EEALGWGE. fEZM-31£13)
[CBRELTHFELLD ST HIET, LRRDBEBLALBDOBRSDENKREGYE
9, R LDEBEMACTERELLER/ME. RKIEKZY/PNSVFELFIXREVNGEL. £
NENFNFEREERDOBRBOETHESNDZEIZHYET,

B DI DH—T DIEE (Dynamic curve power) 147 av AT HIET,
BERFOBRBESONRELYRBEICHIETEET, COFATLavIE [54T31)
— (Library)] » TTH9RXTLwar <y (Expression Maps) IOTBEATa> 0
LEE=1E$R (Playback Options Overrides) | 293> T EENDIHRT Ly gy
YT TCLESHTEET,

MAEDOEE: BEIZELTMIDI EYFAUREFEALT. MAEOEYFEEERTES
FIITEYFELL,

VST /—hIHRTLwiar (HALion Sonict® Pianoteq ZETEM) 1 VST T4F
21— (NotePerformer 7x& TfE ) TIEAL. MIDI EVFARUREFERTHILICIE.
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LOMBI2R\BEHYET  MIDI EVFRURIEF Ao RILERER]RET DAY
U THLS O WMBLBEVFERE T HEOICELGLIEYFAUNENRBLEIZLS
MBIZERTEGNIERL, TST 120 MIDI TS ZRBYR—LTLBEYFRY
FEEE (@%IE 1 RTYTERIE 1 7942—7T) %, Dorico [ZBEIMIZHIERTTELRNS
LB ETY,

LWL, B RERETERIIREDARTIE. MO EBLEIZ MIDI EVFAUKREE
RAT5ILCBRFamanhbVEzEd . LEEOBNE-ARXDELLIZERIGLENT ST 1>
(Kontakt &) THMASBEEETEZS-E0. MIDI EYFRURD AytE— (& MIDI
EZHLOBRICTT—RICEENL-O. WABEYFE DAW DO 7I)/r—3y
THHATESILLETT MIDI EVFRURFDOMABTOBEADFERIEA TR
TH51=6.T54TF1)— (Library)l] » TZTHVRTLvia>rvT (Expression
Maps)lIZ#HzIEMSN TS EDEAE (Microtonality playback) I A=a—h5,
TITAVITHUBEEBEE T ARELHYET,

B&ETVIL—+H
FEFZLE . THA (Play)l » B4 T FL—b (Playback Template) ITHEE T 7L —

FEESHTIR. EEHINETUTIL— ML THREDIFAILALEESNDEES
[F. BEENHSNSRIITHYEL,

B&EE—F

HERTINDERERDIL—T127 ITEBFIVNEERTHE L OESIEITESRDL.
BEE—FOYIBZEIZEADOLSYIELTRREINDLSIZHEYEL Iz, ChIZK
Y. ;FS9PLYRRGA— 2L DN IL—F 424 (Routing) £ 3> T, KAV Rk
YILAVEDBIREFEEREEANIATHERDELIITHYELT -,
ZhIZ&kY, Dorico 3.5 £FTHD/N—a> TIEF|ATE, Dorico 4 hoDBAEE—FD
BREEICKY—FHICHIBRESN - ITERFINDE AR ILAVRERBEIZIELT
BRAIVRRAUMIN—TA2 T TEDEVSHEEN, SN2 LIZBYET,

BEDLEZFEHRZ) v TEE (Play)) » TBEEDO LEEZZEHE Y (Reset
Playback Overrides)1Z{# AL T. KELBRGENSBED LESEZHEIRT S5
BOEEL., LFTIDON—Dar Y KIBIZEFRIESNFELT=,

AR I

Hub AR T O URE4ER: Hub DT ETRERL (Create New) | X— Tl (Bars)
[CRBICAALIZ/MIROEN., BED Y avhfZ+THL EyiavBTchiE
SINBELSIHEYEL,

Jin—H I —5

KEAMDES: EEAF T3> DMN)/N—H)LT—) (Rehearsal Marks)IR— Tl
ER DBAREIE D) /\—H )L T—% (Position of rehearsal mark at start of system) ]
MR DOMRICEHETERZ (Left-aligned with systemic barline)l(ZE%EL
=5 E. HED/NHRDORTOEREZRMLTIN—HYILI—DVDKESBEH
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Sh. BISHBRORBMEICKEE—HIT SLIITBYELE,
JE—HE

BRANSUE—MEIEAE AL FHRMERT 2UE—MEIOBHO €5 A O BET 2L

RF

—LAVERADERERMZEEALTRET HEE. RAFEEDLTATLNEE
SNBHEIITHRYFELT=,

KRFFDEE: Dorico TlX. ALYV IL—TIZBIT 2R FEZRICEEMEICHIA A T3

A9 Tk

VITEITREShTEELED BT IVL—TICBTHRFICELTIEZES TS
YEEATLz, COEH. 1 DOMEDHTEGS DRFHNRGLIEEMEIZEY
BToNDERHY. RLMEICEIYETONDEINEFLMEELHYFEL=.

SEEA T3 DA (Rests)IR—C DA DOBEIE (Rest Positioning)l o3
VIS TRAICESICHLIARFTOEESRDOES| (Align rests in the same voice
vertically) |47 av iz ICBMEnELz, ChETRIC/MIRIZHSEE (When
in the same bar)lIZEEE T 5L FALFEO TN TORFICRICEEMENEIY L
TondLIITHYET,

A9 Frary—IL: TR Tk (Script)] » Ta2)—)L (Console) I Tl&. Lua v R%

Dorico 5 Version History

MERXTEITTEET . SEDOV)—XTIE. LTOLSIZaVY—ILDBEENK
RIZHESNFELT -,

FR91)Zk (Script)l » Ia>Y—)L%IER TR (Hide Console) | A—1—I1EH
HEIRSHh ., HhbYIZTRHY T (Script)l » [a3>Y—JL (Console) 1A+
RIS F—HR—FLa—rhvk 1 DT FEOv  TINEH#EHT.
AVV—ILDORTKIFERTENYBZOND LY FELT =,

Ay —ILIZTEI—&E (Always on top)IF Ty IRy o AMNFHT=IZEMS
N VY=L ERBRMOD R ID LIC7A—MELTRRESNSLSIEE
TEDIIITHYEL COF Y IRVIRDIREE. MED Y3 df
(T THL Byl avTchishET,

Yyl a B TCaVvY =LY A REMBENMREFIN S LSIZHYELT .
aAVY—ILEBORTEA—RAVETEDIATIVRAARAUIE D RT)
VRA—H RSV FHIETHAREERTEET , CNODRAU D EXHILR
YA RXE Yy aV B TRIESNET,

aAVY—IILOH AIZIEZEIET A+ M Source Code Prol MMERSNET,
aAVY—LERWEE MBIRETEATURAARAIUR T+ —HRENFE
T, AVURAARMVIEEELNBL ERBITITEENRTINDIGEHFE
RENERIZHY ANTEEDNELLDRAU T, AVE—T)2—DH AN
RTRSNDDODBELELDRAUM, KYHHIYPFTLEHEYEL =,
ARURANRAUITEBITO A NN TES LI YELT-, [Return] T
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EHRITHEBMEINFET , RYUTEEITT HIZIEIEST (Execute) I R2U %
21999 Bh . [Ctri]+[Return] (Windows) F71=[& [Command]+[Return]
(macOS) ML a—thvbEFEALET,

<A MERE: TR T (Script)) P 1$¢EF < 0% &L (End Recording Macro) 1%:#
RLTIIODEREERTTHE RAVITIDRRIERET 5LIRBSNDHELLIC,
BEMICO7MILBIRF(TOITRRREN, 21— —TF TV r—2avDT—474
WA —NDBEYRR ) TR AT 74 LR TRKES ISR YELE: (S2IZRE
SINF=T—2FTRHY Tk (Script) I A=a—IZRFTSNhET),

RAOVTEDY TAZa—: A—HF—TFT)5—23>DF—2T7+)LF—DI Script Plug-
iNS |74 WA —RIZH T IH VT —EERTHE TRV)FE (Script)]A=21—I23%
DBREFEALTY I AZ2—DMEREIND 2O ROV TN TSTAV DR ELER S
[CHYFET, E=. ROVTDNTA—N\IWTT) =230 T =374 —I2H 515
BRI THEFIODHEHRAENET,

S TING: TROYTE (Script) IAZ1— 2R RENDBR VYT ES v TINGI MDY
H—TEBLIIHYELz. ROVT B DEEEANTHIET, RITTEHaTUR
DYVAMIRTREINET , RIUTMBTROYTE (Script) I A=a—DHTA=21—AIC
RERSNBBE. RVVTRBITHENTH I A 12— FIIRICRRSNFET,

BHOTUREERRITTERIVTR: LRIO/NA—230 Tl BHaY R ERRTT
BRIV THE T LBERTHEENFONFELEATLIZ, 2L 1 DDERNZE
BEIRLT 2 DOELZTONTAEE K LTERET SRV THE. Dorico hRD#mEE
EIEBIETDRNERMEICOVTEMLAL =S, LIELIEREK T HIEnHYE
LTze §TIRRVV TP ERTTEHRIC. MESLICRMTH57TO—FHAISLN., TD
BEREXV) TR KYERIZEFTINDKSIHYFEL-, F-2hizkY, RHYTLT
AT RTOBEE. 1 RATYTTRYBEEDILIIZEHO>TVET,

F—K

AVRARYIWAVLBEEER: IRE (Setup)l P MU RFYILAVIESEER
(Renumber Instruments) 1Y RN FH-ITEBMENEL =z, CNIEHREE—FDT
L—Y—/\RILIZRTRENZTL—NY—DIBEBIZHL., TADTIFAD AU ARy )L A
VNEBEEEIHLNDTY,

FEZIE. TADIIMZ 4 KORILOHHY ., TDEEEERLI-ETIL—V—D
IEFEEEZRDDLENHOBEBEIERN TS, TL—V—/ R TIL—V—%F5
VI LTHREZ ST TIEAV AR AVNE S EERINFEH AN, D009y
TEEERBRTEDLIIHYFL=.

ARSI AVRDIEER: TL—V—/IRIVIZRTITBAVARYIILAVREIZDLNT, Ch
FTIEN=230DHBAV ALY AR THNIXEABRED TERRAD L EH L BN
NTWELEN, SRIFAVARIILAVCDBRAZERT H/\—2a0 i HS5E0
H TXFAMZIEDBADRE I EBMENDKSITHYELz, XK U HHY
JAVICIEEETREBABTRHD BB ENELLIN—Dav ARSI TUOET AN,
ERDAVRYIILAVDIBIR T, WTFNERLTY , TDT= . LATIENUR S
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Y IA LT L——/\%)LIZ[Baritone Saxophone (E flat)]E&R RSN TLVELT=
M. TR ETH S8, IR (IIBaritone Saxophone |ERRENET,

BELT. SOV ARRYILAVRBIEEIN—FATIRDTIHILN B DERIZHIE
RAEhEd, CNIZKY, ZFLATIRD 1 R=CHDELAHDBRADTFAMIIE,
f=&Z LT Clarinet (B flat) 1D K512, BIARNB N XF TRIRSINTUWELz, §TIEH
FMICEUGEILRENERAINSO. RO TFRAMIIL, fz&Z (LT Clarinet
(Bb)lERTEINDKIITHEYFELT =,

KON

ERSNILELTOTIL—V—%: LAT7 oA Tar IR EMB (Staves and

Systems)y\—/l [FL—Y—& %R (Show player names) |47 3> h\EN

N ERIRNIVITAV R LAV TR GLTL—VY—EZFERATHNEID. &5

IJ?"\'C(D?\EEQ (On all systems)|IZ{ERT5h . [RIDDMBEDH (On first
system only) |IZERATEM. FEETE ALY FELT=,

ERINIVOBREICHITHTHE: BHELET—RATE TAVRR LAV EZHRE (Edit
Instrument Names) 15 A 70 THRINILDKEABMDENLITRIE LEEETS
EVRERIANIVICRBENSKSITHYELT=,

BROAR—IVY
IL—LDEEEERTAOOr—48— BEEKEDSERERTIOOr—8—RI0D:E

WEHLMYPTLTBE=HI2, IL—LDOEEREFRITAOr—42—IE. ARATIX
HER—URBIZRTRINSLIITHEYELT,

Steinberg 5/t X

Steinberg Activation Manager M & #ThiRASws78: Dorico 5 [ZI& Steinberg Activation
Manager /A\—>3> 1.4.30 LIEAHETYT , CREBTD/N\—23> D SAM #fERAL
TWBEEIE. BT T7YTT—hL TS, SAM 7V T— S RLEHGHE
(. Steinberg Download Assistant #%£173 52T,

TX¥ Rk

TFTXRARIL—LDESRBERBOR: TONRTADITFXRL (Text) 1T IIL—T (I [E&ER
(Background color) 1ETH4RD & (Border color) 1D 2 DD TO/NTA4 M HFHT=IZE
mah. 7T¥RRNIL—LONBEEETEDLSITHBYELIZ, SN TA/NRTAEE
RAT3ICIE,. FEE—FRY—IULRYIRDIL—LREEZEDICLTHL, LEET D
BROBOERBREH OTHEFANIL—LEERLET,

SHITER: THRE (Edit)] > TE5ISEIR (Select More) I [24E B4 BIEA FT =T BMEH
Fllz, BERFLIGFHMEBICHKTFRAMN AT LE 1 DFRLTIESITEIR (Select

More) 14173 5 MDTXFANTATLDSISEREC/INTT S TRV EFERTSE
DDHMNERENET,

INGTSTRA(IEER: [HRE (Edit)] » EREE (Notations)] » [T+ Xk (Text)] »
(185957 X84)VEZEE (Change Paragraph Style)1% 4704 A#f=(2B NS
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NOBRUEREFISHRRICAKT I RN AT LIZERSNG/INST TR ILE
EETELLSICHYEL, INIE, BRAISEBIRLETI RN AT LERIL/INSST S
RAAANEERTETXANTATLEZEBMTEIRT DFHEEIEHITER (Select
More) | LA B HETHEHATHEEFTT,

Unicode DTFRAMAN: TXRMNPATLICERETLEZANTHI5E. RLBELGH AL,
B2V LAV THFRMZ 21— EETHFXMEHEA (Insert Music Text) 1%
BEIRTBHIETT, NITKY . SMUFL DI RTOEFREEERTTH54/7ATH
FE. AALEITRTOEESICITEEMICIFRTX AL (Music text)|DXFEREA
ILDNERESNET,

NETIE. TN LS DEED Unicode iEBE ANTHDILESTLI=A. Dorico 5
KYUFT-HBAEDNBASINTVET  ERFLISHERICATFRNTZATLPTER
FIL—LTTHFRINERETHEICIE AT EIXFOIA—FRAIUEERHT 4 X
F0 16 EHEAALT [AR]F[X] ZANT HE. 4 XFHAEL)AL Unicode XFITE
SN BARDOERICAASINET,

-z IE KFEDEBEST.. 1Z(EX,. a—FRAURU+2026 INEIY L TONTULVE
9, Dorico CChEEATBICIE. THXFRAIT44—I12T2026 1A HLTH DS
[A]+[X] EAHLET .

16 EHMTIE. 7IE7HED 0~ 9 EA—TFEDA~FZFEALET . 151 2%
E(FfRE, REAICFA—RRAUMU+00B7 1M EY K THN TLVET , Dorico TS
NEBATBIZIE, TEFRFITA2—IZT00B71EA AL THS [A]+H[X] ZAALFE
T o A—FRAUMEEIZ 4 XFITED KT, LRBICIKN0IZMADIBELHYET,
Fo. INZHITTLEITELTEET  FARDICED 4 XFH 16 EHELTR
BINLGWNESIE. ADYICIEARDITCEIZHS 1 XFEHARIET HA—FRAUMC
EHINFET,

TEOHEE: EROIVFA—LEFERLT. BLOTFRANTATLDITHE
ETXARITAB—DRYTA—IN—hoRETEDLSITHRYELL =,

TOCIODTAL—3v D=9 AP ORDEFHTaAL—a v ERRT B=6HD
UTOR—=oo B FfzICEBmMESh ., TRRNIL—LTHEATESLSITHYELS:,

{@projectDuration@} (&, [4'33" 1D K5I AS> -5 AFAERINET,

{@projectDurationStraightQuotes@} (&. (4'33" 1D &KS5I1ZF >3 <45 H
RMNMERSINET,

{@projectDurationPrimes@} (&, 433" 1D KSIZTSA LM ERINET,
INEDL—YUFBATBICIE, TRFRMNIL—LTTFRMNERERICEI)VIL.
[FOSHMESR (Project Info) | T A= 21— MDIEST BTN —&BIRLET,

macOS DILFEARAFANINEEF DT+ I 73— Windows & macOS DI+ b7 731)—
D/NFDEVNTENGDA ., 4 DDEERSZA)LE (Regular, Bold. ltalic. Bold
ltalic) LS DHEIRR B A LTI, Windows TIEZD 4 DDREAILLMEFREINT .
RRTDRAMIVIEBEIMICERLET LR L HB TR T7IU—IZKFDY
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TARHEULMEE . Windows (LREEIRIICKFE/ERLET . — A macOS [, 74k
D7) =BT NIEESLENRESIILIZ DOV TEEM AR BIIHYEE A

f=&Z X, JIED macOS [TEHIN TS Futural 773 —%HlIZE>THET,
Linotype ¥ URW Type Foundry MM 23 5 DEERD R AT KXY SHRGR 524
IWHARAESINTWET A, macOS ICEMEIN TS/ N—232(21E . Medium.,
Medium ltalic, Bold, Condensed Medium. Condensed ExtraBold @ 5 DD XA2A
ILHRHENTOET,

Windows TlE, CAHD I/ MDENENNMILI-TH T 7S —ELTRRS
N, ZTNEFNIZ 4 DDIZERFA LT 5S4 R, TFutura Medium Regular].
lFutura Medium Bold]. IFutura Medium lItalic]. I Futura Medium Bold Italic]® &
SCRRENET . CDIBTA RV LICERICHEET 5742 8T74ILIET Futura
Medium Regular] 217 T, 10 3 D1 Windows IZ&KYEREIN=ELDTT, =X (&
[Futura Medium BoldJl&. EMEDIFutura Bold D74 b I7AIILEFERTHIEF
HYFEE A, Windows [EFutural&lFutura Medium JIZBHED 773 —&ELTHKS 1=
HTY,

—7 macOS Tld, RZAILDARL—TFT AU VAT LIZE>TERSINBZEFTHL,
(FEAED macOS 77V r—arTlE, EREICAVAM—IILENTNVAREA/ LU
BIRTEEEA,

NIEVARTSYNIA—L DT T )r—aviib oL -BEL-6LET . &
RS, ILERRFZAILDFBWNADBRERNIZELZD LT TR TR T7AILIZIET7
S =BRSSBT NETNELEDIAETERINTVNAIED , ARL—T 1Y
GORTLIEIZ. EBIZIEFDARL—T AV TV RTLEDT T ) r—30 T kI,
T+ DRBPCTHLDRIZHERT HEHRNELDS. EVVS-ENH L= TT,

NFETO/N—23VTlE, 5L 0S DEEICHIGT BE=02, FAELZ G EE
W TEEL=, Windows TIETARTHAL U TILTT , TRTDIART7I)—N
4 DDBERIAIWEEFE . TNUNDREAILIZDOWTIX, ARL—TAV TV RT
LOERIZHL, BGST773)—ELTERRSNFE T, LA L macOS TlE, 747
7 —IZE > TRESNDEBRD L FI{TERZAILIZHIZ T Windows M 4 DDA
AW ERTRLAZEZRZAILOWT AN HESNATOVEWNMESLETHZR2MI)L
EFRIRTEBLSICTBEHICIK, BT T)r—230IL—LT—ODIT+0RE
EEICIRTELTEELT=,

macOS [Z&F NS Futura TA2 b T7I)—DHIIZERSE. LLRTD Dorico Tl&. 7+
DR INST ST XFRIAILDITA R T7I)—ELT Futura 2R, (ZDLHE]
EHFEDORIAILDFELLZNZEN M HET) X321 )L%E Regular [ZERFETHEMNT
EFFELz, EREICIE, TPV TRIREINSTFRMEL TIEFutura Medium 1AME
BAEndlEIchYEL=,

LAL. RIFEZFDTOCIHMEERT 5L, IFutura Regular A 7EE LA LELSE
EHREELNFTT, TODTYMIE Futura ZERALET XA RRSINTLNSI=8H.
ZENREE>TWDEHIERINENELNFEREAN, EREDECAHZEEIME->TULE
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A, [Futura Regular W EREh . LMALEFEELLELDTY,

ZNIZx BT B1=8. macOS kit Dorico Tl VAT LLICHEHET DT+ L7731
—DBAMFEDRZAILDAHARTEINDSEIIRYEL=, ThlE, TTAHUFREAIL
(Font Styles) . [/\5%5 527 X424 JL (Paragraph Styles)]. [ 3XF X424 )L (Character
Styles)IF A7 AT, THFRANITAE—DRYTFH—IN—12E T T73)—%
PRALINWEBNRTEINDTT)r—230 DT R TOIGFHICHELET,

TR TI7I)—EBLI-EE BAERPOBFFHFERZMILNENITREINT
WSS, ZAIZHATESR BRI ERZMILNBATRMISERSWE T, =2 (E
[Futura |Z#ER T SHE. TRegular ] E#ZIRL KSR EMNTHD TIF AL, BEIMIC
Medium JRZA JLAGEIRESNET,

SHICIRESNRAFIMNILHBEELTEERZIN, TN T7I)—DBIRE M AT DT
RTCDITAVRRBLIVENSTSTREAILNBEEFEIN, TRTOHET HREA
LD, EETDEHMTERFSMILBIEET HELSI1HYELT,

DFY . R ECTIEREELEVWRASIILILEIRTES . JO o/ 2HEELTED
FUMDNFEELGENEWNSEE IR FREINGLRDENSTETT,

BRENL,. COLIBILEI+VCREAMIVEFERTETO0 UM% macOS &
Windows DEITHENIT AMRICRLET AR AIEDOBREIZK L. CHIXFAI DR RIZH74E
YEHA, COXIHTADHREMD 0OS TRKEIZEK. TEELEVWI AV E
(Missing Fonts) 144 705 TIAVMDBEIVEL T E#EBEIZITEIDELHYET,

FITNv—T DEEES: UAID/N—230 TR M ILOBREERT OO ILES

DEDF TN ¥—TRENNKRE DM o112, BRIFREEERELTRPILL
ibf:o

1—Y—A28—TJ1—X

Dorico 5 Version History

BAERICEEANYFRIZER: RT—2AN—IZTHBEAYFIZIESE (Follow playhead) 1D X

FARRAYFDOFZITIEEMEINFEL -, MHAFRETIE. SNIFFHRTOD /O RS
BFICIE,. RBZEDIBE (Play)IR—CDIBERICHEEAYRIZER (Follow
playhead during playback) 47> 3> DKEIZRWNET . BEE—FOBERIZ,
RAT7 X —IT43— VI ENBEAYRITERLTRIO—ILT HMNESIHIE,
TaCz I 4R CEICERICERETEET . L. ALTAS I THEED D
AR IERANTVSEE 1 DDAV FVIFBEDRICHEANYRIZERSE. FIDOY
AR FEA—DRBEIEEZITHOGWRBYFLELI-FFE. EVWSIELETETERNT
T, CDHREIX. BV DEY IV B TRESNET,
COHREENRIALF—HR—Fa—thybTUIVEZ S5E6F. REREDF—KR
—k>a—kAvk (Key Commands)IR—I Tl 42Ky (Window)] B TEHEAYR
[SBHEZEYIYE X (Toggle Follow Playhead) 2 a—rhyhEEIY L TET, Ff=
FOYoTINEITATURER YT IELTEET,
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LA7 O DB WEDLAT7IEMNTEEF (Concert Pitch) 1F - (ZTHBRAF

(Transposed Pitch) |IDEELTRIRIN TSN ETRT HAELN—F DR LR
AVICEEFMAON . [RE (Edit) I A2 —2FALGCCLRENDRAZEEEET
EFHEIITHYELT=,

Ea—447: [R—UEa1— (Page View) &ML —E 21— (Galley View)1%:E R T BHK

AyTA YA a—N—R DR ILREAVIZERIN, TORTE2—R(T42LET
BRIZ 1 D IEHTEDESIZHEYEL=,

SRJL C DER: N—F TPV INIT T DA—N—IZ&>T A V2—TDEEFIT R+

—LARED=O. BRETINAR Y INIFTTI ) r—2av T3 AUBTHE
BRI LHESREANELHEEAHYFET .

VAR ETIL, EFJL C (MIDI /—F 60) I& C4 EBEFITEINET, ChIXELED
NTWBEEEYFRIEDEKBIZEDIED T, Roland BEDA—H—D ot
AH—HIZBLIDREEIZHE-LTULET, LHL. Steinberg DFDMDHRART T4 —
3> (Cubase #2&) 754 4> (HALion #&) Tl., #EARE TILIFIL C 1E C3
LB SR FINTVET . Y IN\DIoEHA(F—ERE, SF)L C (X C3 LB S{FIT
SINTWET.FE 3 DARELT. HFEYILELFEOLNTIILEE AN, Cakewalk &G
TERLTWSEDT.SFIL CEC5 LT BEDEHYET . 259 5HZLT.MIDI /—
b O AYC-1(SKIL C % C4 ELI=1BE) 42 C-2 (ERIL C % C3 ELT=15A) IZIF 5
9.CO LF/ESFTENFET,

Dorico Tl 7T —Lav 2 ETIFL C DBEMHT TN R
DHEEBIRTEDLSIICHYELz, COREZEF T HICIE. RERES(T7RY
#EE. T2 (General) IX—C TIERJL C (/—F 60) (Middle C (note 60))1%TC3].
rca). res1oVnFnmIZEELES,

CDREFTIVT—Lao2EDAI3—T OB SFTICREESEZFT, ChICIE,
F—ITA4F—DET7 /A=) F—HR—FNR R RTF—EXN—DERFOEHFD
FEAHL.MIDI M) H—481E, TO/8T 4/ IILDI8X (String) 1T O/8T 1, [3&EF
—Z— 5 %##%E (Edit Strings and Tuning)J. [#88 (Transpose)l. TEYFTEH
%#74)L32— (Filter Notes by Pitch)]. [FC5E (Write)] » [Z#: (Transform) D&
FAT7AT . ZDOMRAEVRYIRATEYFEIEETELIHLWIEMNEENFET,

TI)r—23>OHRT 1 EHFRF.INL C ORBE/BILTIESOMNS/4TS5)—
(Library)] » TTORTL v a><yF (Expression Maps)I T3, chlZkY, H—
FIR—=T4—DTZT A 0Y U TINFATF)—DA—A—DRF 1AV THEAEINS
BEMTORX—LE MDIBATIFIL C DRBELEFTILHELG—HIELN
F9,

AVARYILAVRDFER: BEE—RDAVRARYILAVREYH—T LAT7INNEZ I

RAEMN K- TELGLIERIEEEERATHAVALYILAVMIDNT, ZILRAOT7 LA
T IrTIEHLIBHESEFAL. /IS—FLAT7IRTIEIBIDEDEZFEHRET SEL05E
BREHBCRETIIEL LA OO ERENBRATHNEVORBEEEATHEIIHYE
l./T:o
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Y—ILFVT: TASz O I4URIDTRTOREUIZ, BEIZIGELTY—ILFYTHRRT
ENdES5I1EYEL=,

BELGEWIFU TOSHMERKEIC, TOC 9D TFHR AN AT L, TV bREA
W INSTSTREA I XKFERBAIDBV AT LIZA VA= ILENTWVEW T+ E
FRALTWAIEEFRET AIEELLZWLIA U (Missing Fonts) 15 4705 AR R
SNBGEE . FELGWIF UM EIEETHRRFIMILBLEMTRRT 5LIITHYE
L=,

BIRFA470T: BALwRELYavhTHNIL, #8858 (Transpose) 15 (7O EHERT
Li-&=. TERARILA T ar %@ (Apply atonal spelling options) ] D BTEER
LI-EAREFINDKIITHYFEL,

I —TFAZBEHLIFS (T OY: [H—TF4FEESHL (Export Audio) |5 (7OJ%
BRALEEE BIERRLA —T A B E (ST 2583 EVMRRENRE
ShBESITYFELE,

A—hZM4E€—av: ARAUEE, RILMTILEE. PEEFE T Dorico #ETLI-5E&. —8D
TI7AHILLDER (FzEZ21EF147RJADIOK]. [Cancel]. [Applyl. [Close % &
DIRFUIZDNT) BRIFTTWELIZA, SNED T IHILEDOERMN TR THISKSIC
HYELT=,

BRE —Y—LRALOT7T)r—arT—2T7+)LF —KHNOD gradients.xml 771 )L
[C.EEDOHDRIREAEEFE DI ST —avEEETEDLIITHYELI, 25L=Y
ST =LAV IR EEHOE R CTERLZEBYICRRESNET 1L, 4 DEHBAD
PEREFE DT SIT—2a00 RIERODHNRRAUNGET ST —av ik, RIER
ENDIH5— (Colors) IR—UTIFERLI-ESYIZRRISNEREA,

TINARERTE: BEDA—TAATNARDEANRTLADRT TIIEL U IVE AT
HEENRESNI=-BE ., THRE (Edit)] » [T/31REKE (Device Setup)l[TZ&
ARTEN, BREZ MR T 5151 Windows DA —T+ 4B EEBIERT 5FIEE
RELEFLYDR—RBEADIVINRKRTINDESITHYELT=,

TIHINWRDTSTAVHARSAE— RIBREDIBAE (Play)IR—2IZHBTIAILE
D FILR)L (Default output level) IRSAF—IZ REDRASA T —EDET A
VLRI RTEINEELSIZHEYELT,

RELLGVDBAER: BEIFFICE., #HEIND VST AV RRY LAY YU ROV Ty
MIELLAVRAR=ILENTVNSINFIVIINFET  ERPAVTUOYNFELLGNE
HEr SNz EE RTINS AV E—T (K, Steinberg Download Assistant #2H T4
VA—FLTAVRN—ILT ZRENHEHE Vo O—MEFMD EELGZBAARTEIND
KIITHYFELT =,

Dorico [ZfHBT DAV R IILAV RO TUVEFERET . AV R—ILHBRBELLY
BEIX. T TrOIBERRLEL (Don't say this again) I F Ty IRy IREEH
23 5& IRIFZEENRTINEEA, LML, —EBDEZRIL Dorico DAL T )
=3 AV AN—5—IZ&2TAVAR—=ILEN, ZTDREIFXKYILEEHLZA 2V A —
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ILOBEEZRIBNEHA-H. COAVE—DFNFETEFEREA. SRIDAVE—
ORRRENGENEIITTBICE, 7TV r—2av AU X—F—T Dorico ZBA VA
F—ILL T AV R—ILDBEEZITEO TSN,

959 albih—bD BENNE: B A — Dorico N5y alLi-154 . RERZEEFIZISYY

aLR—k% Steinberg [CEETHTAVTINRREINET, V5 v albR—HMII
BEAZBETEDIERIIEENTEST . ¥5vi a0y EFY—N—I27yTO—rE
NABEICBBMICI7AILEANERINDZO. TDITF7AILAIZAERINET,
CHETHNE. V7V aLR— O BEREEELICELTEHIELTEET £
EDFOLGHBETH. HoMLHERTHI L% Dorico YTy aLR—k%
Steinberg IZEETHLIEHYEE A, VIvialR—bhREIS-LIZTOY
TEMFREN, Steinberg ICAYTEEETINESHERONET,
BRNEDFELEZERLI-HL. BEBREXBIRSEIEEE. REREDI £
(General) JRXR— Tl Steinberg 295y aLR—bERETILERIERER
7~ (Show prompt to send crash reports to Steinberg)1Z &% LET,
TUISvL 2R % Steinberg ITEEL TS INLDERICKY., H1ETT
Jr—2ar DEBERRESITBIEL, YVIMIZ 7D RER LETXTO Dorico 1
—H— IR TELLSITHYET,

INFA—H—BREODHAEYT7— TAD I, IR I DEE—RTHARYT—DET

REEFECEXT B finishedTours.xml 77/ J)LICDWNT, 2A—H—BEHDT—4T+I)L
H—TRETELRWMES. VY O0—N\ILaA—HY—TFT—274IEF—hbEHAEND LS
[ZHYELE, CHIEBE#ELEDTIILF1I—F—BETHRIZELET,

Dorico Elements ND&E K

Dorico 5 Version History

Dorico Elements D#EEA LT D LI ITHhiRENFELT =,
TODIHPCHERTEDTL—V—EHOEHIRICAYEL: (TR 24 £F
T),
B4 (Play)l » TBE4.47a> (Playback Options) IAVEBnsnEL =,

42 b R2A )L (Font Styles) . [/355 57 X441 )L (Paragraph Styles)].
[XFERAAIL (Character Styles)1h\[S54751)— (Library) | A=21—I[Z18

mEhElLE=,
BEE—FFTERDAR=I UG ELERDAR—= VT DEY—ILAEMS
;h'il./f:o

F 1= Dorico Elements IZ1&. Dorico 5 TEMEN-FHEEDSL. [S4TS51)—
(Library)] » T4 X)L AVE (Instruments) 15 47 045 #BR<{T R TOHEEEH B
mEhTuWhES,

L EEDFHEEEIT Dorico for iPad TH. B3 A ZEF - (X EMEL. F=IET7TIRNE
% lLifetime Unlock IZEBALESESFXFIRATEET . HITRIYTLavFRF
Lifetime Unlock A& %h7%: Dorico for iPad (. 488 MIDI T/ AMSDBEAEL YR
_FLQETO
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Dorico SE D E
Dorico SE D#RELIRIESN . K 8 ADTL—Y—HWNBTOPIHMTHETES
FITHYFELz, (EKEBY.8 AERBZEZTL—VY—DHWN5TO0V VI BES
FUHIRIMATES)—FA ) —THREET, )
F 1= Dorico SE IZI&. Dorico 5TBMEN=#FaED 55 . 54T 51)— (Library))
» TAURRYILAVE (Instruments) ], RT—U T TL—RERR—RTFUTL—F,
A9S5THEA ., MIDI M) H—4EEL. Groove Agent SE ZFRUL =, ZLDHEEEAHYET .

Dorico for iPad M#EEELEIHRICHEIES L. EFIRTIXE&K 8 A (Steinberg ID THA
AT BE12 N) DTL—N—mH NSO/ THRETESLSIHYELE,
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Issues resolved

@ steinberg

Component Issue
Accidentals Under some circumstances, changing the accidental of a note would not cause the accidentals
on notes within the same bar to be recalculated right away as required; this has now been fixed.
. . Articulations that consist of multiple symbols would draw incorrectly when positioned on the stem
Articulations . e
side of the note; this has now been fixed.
Bar numbers Under some circumstances, bar numbers would not update correctly when undoing changes to

local time signatures; this has now been fixed.

Brackets and braces

Dorico will no longer allow a secondary bracket to join adjacent players with identical instruments
that are in different player groups.

When changing the tuning used for chord diagrams shown for a player, Dorico no longer

e/ ey unnecessarily resets the choice of shape back to the default one for that tuning.
Chord diagrams Qhorq diagrams that are created vig Generate Chord Symbols from Selection will now show
fingerings if enabled via Layout Options.
When changing the capo transposition for chord symbols, Dorico now automatically resets the
Chord symbols appearance of any chord symbols that have been overridden; this prevents overridden chord
symbols from continuing to draw using the root of the original capo transposition.
Under some circumstances, it was possible for saved chord symbol appearances in Library »
Chord symbols Chord Symbols to have a mismatch between their saved transposition and the displayed chord
symbol, resulting in chord symbols showing the wrong root in the score; this has now been fixed.
Vel eyl Under some circumstances, Dorico could crash when using Edit > Reset Appearance in a
Y layout showing both chord symbols and chord diagrams; this has now been fixed.
When Clef at start of systems following first system on the Clefs page of Notation Options is
Clefs set to Hide clefs, Dorico now only hides the clef if the system contains a single instrument, and if
that single instrument shows only a single staff.
It is no longer sometimes possible for Dorico to get caught in a loop of selecting and reselecting
Comments the same two comments in the Comments panel when navigating quickly through the list of
comments with the arrow keys.
D . In rare circumstances, grouping dynamics, then undoing, then re-grouping the same dynamics
ynamics -y ;
would fail; this has now been fixed.
Dynamics Deleting individual dynamics from different groups of dynamics now works correctly, instead of

only deleting the selected dynamics from the first group.

Grace notes

Under rare circumstances, grace notes could unexpectedly not appear at the start of a system
where an explicit system break is present; this has now been fixed.

Guitar notation

When the Pre-bend interval property is set to a negative value, the automatic allocation of notes
to strings and the String property could behave incorrectly, causing some valid pitches to display
incorrectly as ?; this has now been fixed.

Holds and pauses

When a fermata appears both above and below a rest, the fermata below may have been
incorrectly positioned if the single drawn rest represents multiple voices; this is now fixed.

It is now possible to redefine the shortcuts used to switch between Commands and Go To

Jump bar modes in the jump bar.
When dragging the range selector above the main keyboard to either extreme of the range, when
Keyboard panel the mouse pointer leaves the range selector during the drag, it was possible for the drag to be

unexpectedly re-interpreted as changing the displayed range; this has now been fixed.
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@ steinberg

Component Issue
Dorico could crash when updating the Key Editor when selecting something in the music area
Key Editor resulted not only in the piano roll being replaced by the percussion editor but also switching to a
different flow; this has now been fixed.
Under some circumstances, opening a new project or project window with the Library Manager
Library Manager visible could cause the Library Manager window to become blank until you start interacting with it
again; this has now been fixed.
Li Lines drawn with repeatable symbols now print in the correct color if their color has been
ines . .
overridden via the Color property.
Lines The Start position and End position properties now once again appear correctly in the
Properties panel for rhythmic position-attached lines shown within the staff.
P After changing the user interface language via Preferences, all key commands now work as
Localization ; X
expected, according to the appropriate keyboard language for the newly-chosen language.
o Toggle buttons in some dialogs were not correctly translated into the appropriate language when
Localization g L ) . )
running Dorico in a language other than English; this has now been fixed.
Lvri When multi-pasting music containing lyrics to several instruments, lyrics could be incorrectly
yrics : ; e ;
linked across multiple staves; this has now been fixed.
Lyrics Lyrics with formatting changes within them are no longer sometimes incorrectly positioned as if

they had hanging punctuation.

Music fonts

If a music font specifies a particular text font in its metadata file, Dorico now correctly applies the
chosen text font to the default font and paragraph styles.

Dorico no longer sometimes incorrectly exports notes that are not visible in the layout (for

MusicXML export example, because they are covered by a rhythmic slash region) without specifying their pitch,
which is invalid MusicXML; instead, such notes are simply omitted.
When determining which endpoint to use for echoing notes played on the MIDI keyboard, Dorico
Note input now considers independent voice playback, and chooses the most appropriate endpoint based
on the selection, rather than simply always choosing the first endpoint for the instrument.
. It is no longer possible to delete all the material in a flow in Insert mode such that the flow ends
Note input . .
up with zero duration.
Input via MIDI keyboard into a percussion kit or an individual unpitched percussion instrument
Note input that has been imported from a library file now works reliably; in previous versions, Dorico could
fail to choose the expected playing technique.
Under certain circumstances, removing material via Insert mode or the Shift+B popover could fail
Note input to remove tuplets correctly, for example when the notes in the tuplet to be removed are slurred to
notes outside the tuplet; this has now been fixed.
Note input It is no longer possible to add a rhythm dot to a selected implicit bar rest.
Note inout Under some circumstances in transposed layouts, Dorico could add intervals with the wrong note
P spelling when using the Shift+l popover; this has now been fixed.
: Under some circumstances, attempting to navigate from the first or last rest in a voice in a
Note input . . L )
percussion kit could cause a crash; this has now been fixed.
It is once again possible to duplicate the VST instrument selected in the VST and MIDI panel in
Play mode

Play mode with a key command or via the jump bar.
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@ steinberg

Component Issue
Plavback The value of Increase written dynamic of other beats in the bar on the Dynamics page of
4 Playback Options is no longer subtracted from off-beat notes.
When applying the Min./Max. velocity values specified in expression map switches, Dorico now
Playback . . o
correctly considers any defined note length conditions.
If you have an immediate dynamic and a gradual dynamic at the same rhythmic position and they
Playback are not in the same group, the immediate dynamic will now be processed for playback before the
gradual dynamic, so the dynamic change will be as expected.
When editing linked slurs or dynamics that are linked to instruments not shown in the current
Playback layout, when you subsequently play back, those instruments not present in the layout no longer
unexpectedly play back.
A messa di voce hairpin of the form diminuendo-crescendo no longer plays back in the opposite
Playback L
direction.
. When toggling between Mono and Color, the Watermark checkbox is now always correctly
Print mode . .
enabled or disabled as appropriate.
When starting a project from a user project template, if a new flow needs to be created, it is now
Project files created before playback is set up, thus ensuring that playback will always work as expected right

away.

Project files

When starting a new project via the Hub, the Project will use multiple flows setting will now
apply not only to the part layouts that are created when the project is first created, but to all future
part layouts subsequently created in the project.

Under rare circumstances, Dorico could hang during project saving; this has now been fixed

Project files (macOS only).
When exporting flows from a project, Dorico no longer includes a thumbnail preview; previously,

Project files this preview could be for a flow or layout that was not included in the exported material, which
could be confusing.

Project files When saving a project as a template, Dorico now removes all MIDI CC and automation data in
any preserved flows.

Project files Under rare circumstances, an unpitched instrument in a percussion kit could be unexpectedly

silent during playback; this has now been fixed.

Script plug-ins

The Lua interpreter on Windows requires filenames for loaded scripts to be encoded using the
appropriate code page for the operating system’s current region and language settings; Dorico
now correctly encodes script filenames in the right code page, but this means that scripts with
names that use characters outside the current code page will not load correctly. You are advised
to stick to characters in the Latin-1 code page if possible (Windows only).

When multi-pasting material including slurs to a different bar, Dorico no longer incorrectly links

SUTS the newly pasted slurs at the new position to the original slur at its position.
Staff labels Instruments that use player names as their staff label are no longer allowed to be grouped.
When Dorico is set to show metronome marks to a specific level of precision, it could incorrectly
Tempo display floating point values with leading zeroes: for example, 152.09 would display as 152.9; this
has now been fixed.
Te Under very rare circumstances, setting a sufficiently slow final tempo for a gradual tempo change
empo : o :
could cause Dorico to crash; this has now been fixed.
Under certain circumstances, a gradual tempo that coincides with a time signature was no longer
Tempo correctly aligned with the time signature in the presence of another tempo marking at its end; this

has now been fixed.
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@ steinberg

Component

Issue

Tempo

The abbreviation for circa in metronome marks has been changed to ca instead of ca., i.e. the
period (full stop) indicating the abbreviation has been removed.

Ties

Edits to the endpoints and curvature of a segment of a tie at the start of the system where the tied
is between independent notes (for example, in different voices, or non-rhythmically contiguous
notes) now correctly update the display immediately.

Tonality systems

Under certain circumstances, custom tonality systems in projects created in Dorico 3.5 or earlier
could be overwritten with a different tonality system in the user library that happens to have the
same internal identifier, causing unexpected effects when opening that project in the latest
version; this has now been fixed.

Tuplets

Attempting to create a tuplet where either side of the ratio is zero no longer causes Dorico to
crash.

User interface

The preview in Library » Paragraph Styles now correctly displays foreground and background
colors, if specified.

User interface

After saving a custom ensemble in the ensemble builder, if you switch to the Choose page
without first closing the ensemble builder, the new custom ensemble now correctly appears there
right away.

User interface

The ensemble builder popover now disappears when the application window is deactivated, such
that it now behaves the same as the instrument popover.

User interface

The alignment of noteheads and flags to stems when using a standard resolution (i.e. non-
Retina) display has been improved (macOS only).

When closing a project that was previously displayed full screen, an empty Space is no longer left

i behind (macOS only).

e When opening a new windqw for an existing project, the Mixer button on the toolbar is now
correctly enabled if appropriate.

q If you specify a bar number that cannot be found in Edit » Go To, Dorico will now navigate to the

User interface ) : . :
first system in the relevant flow, rather than doing nothing.

User interface Key commands shown in the hands-on tutorials accessed via the Learn page of the Hub now
show the appropriate shortcut modifier keys for macOS and Windows as appropriate.

User interface Itis no I_onger possible to incorreqtly specify negative durations for grace notes and tremolos on
the Timing page of Playback Options.

User interface The long-lamented disclosure arrow in the tree control in the Key Commands page of
Preferences has returned home after a heart-wrenching absence of nearly 18 months.

. If a popover is visible when the application loses focus, when the application regains focus, the

User interface . - ! : L. A ;
popover itself regains focus, allowing you to continue typing into it without clicking in it again.

User interface The bars in the 'system track would often not highlight when hovered over with the mouse; this
has now been fixed.

User interface When_one of the right-hand panels is shown, it is now correctly updated to match the current
selection state.

User interface The single step size for the spin box paddles in the Zoom dialog is now 1%.
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@ steinberg

Component Issue
. The Follow selection changes on undo and redo option on the Note Input and Editing page
User interface
of Preferences now works as expected once more.
User interface Longer instrument names are now elided in the track header in Play mode if necessary.
: The layout selector in the toolbar is now correctly disabled both in Print mode and when editing
User interface . .
page templates and flow headings in Engrave mode.
Under some circumstances, Dorico could fail to connect the appropriate channel for the video
Video soundtrack so that it can be heard and balanced via the Mixer when reopening an existing
project; this has now been fixed.
iio When playing back video during real-time recording, the video would jump forwards by 20

seconds compared to normal playback; this has now been fixed.
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